
National Oceanic and Atmospheric Administration.

ISBN-0-16-045541-3

Jan 95

125p.


Guides - Classroom Use - Instructional Materials (For Learner) (051)

MF01/PC05 Plus Postage.

*Computer Mediated Communication; Computer Networks; Computer Software; Databases; *Data Collection; *Independent Study; *Science Activities; Science Education; *Scientific Research; Secondary Education; Technology Education; Telecommunications

*Internet

This guide is intended for the secondary school teacher (especially math or science) or the student who wants to access and learn about scientific data on the Internet. It is organized as a self-guided exploration. Nine exercises enable the user to access and analyze on-line information from the National Oceanic and Atmospheric Administration (NOAA) and other providers. The exercises make use of common Internet software tools and provide step-by-step instructions. An introduction discusses connecting to the Internet, essential computer skills, conventions, and NOAA data. Nine activities cover: (1) using e-mail; (2) using finger to find earthquake information and conducting real-time conversations with talk; (3) using telnet to find space shuttle information; (4) using ftp to get current weather information; (5) using Archie to locate programs; (6) using Gopher to study the sun and using Veronica to do key-word searches; (7) using GeoVu to assess hazards (involves charting data and analyzing information); (8) using Mosaic to check the winds; and (9) using Lynx to study greenhouse gases. A brief paper describes the Internet, its history, and its use. A "help" section is provided for the local coordinator of hardware and software equipment. (LZ)

*Reproductions supplied by EDRS are the best that can be made from the original document.*
Internet Activities Using Scientific Data

A Self-Guided Exploration

DEPARTMENT OF COMMERCE
National Oceanic and Atmospheric Administration
Office of Educational Affairs
Space Environment Laboratory

BEST COPY AVAILABLE
A Checklist for the System Administrator

To ensure success with this guide, the user needs to have a system configured to work as we describe. This is a quick list for you to check the user’s system.

For a DIRECT Internet connection (either through a local area network or S..IP)

On the user’s computer (or accessible on your local area network or via teinet to another host):

- a login name and password
- an e-mail program: elm with the pico editor, pine, or UNIX mail
- 1 Mb of disk space for short amounts of time (several hours) for e-mail and other files
  
  - finger
  - telnet
  - ftp
  - talk
  - archie (optional)
  - gopher (optional)
  - Mosaic (optional)

For a DIAL-UP connection (not on the Internet)

On the user’s computer:

- a communications program that emulates VT100 and can transfer files using kermit
  or zmodem

On the host computer:

- a login name and password
- an e-mail program: elm with the pico editor, pine, or UNIX mail
- 1 Mb of disk space for short amounts of time (several hours) for e-mail and other files
  
  - finger
  - telnet
  - ftp
  - talk
  - archie (optional)
  - gopher (optional)
  - lynx (optional)
  - modem file transfer program such as kermit or sz (...node)
Internet Activities
Using Scientific Data

A Self-Guided Exploration

Stan Froseth
Internet Consultant for the Children's Museum of Denver

Barbara Poppe
Space Environment Laboratory
NOAA

January 1995

DEPARTMENT OF COMMERCE
National Oceanic and Atmospheric Administration
Office of Educational Affairs
Space Environment Laboratory

NOAA

Space Environment Laboratory
To the Explorer

You may be a secondary school teacher (especially of math or science), a student, or an adult who wants to access and learn about scientific data on the Internet. This guide provides exercises that enable you to access and analyze online information from the National Oceanic and Atmospheric Administration (NOAA) and other providers, using common Internet software tools.

If you are a teacher, this guide will help you to teach how to access data on the Internet. In fact, it should do a lot of the teaching itself. You might consider yourself to be another student and want to work through the guide. The examples and exercises in the guide are formatted so that you can duplicate and use them in classroom or lab situations. Your main function as the teacher will be to assure that your hardware and software configurations conform to the guide. Instructions on how to do that are included in the Help section, and every effort has been made to make the configuration as common and "standard" as possible.

If you are a student, you will be pleased to know that you will be learning with your teachers as you work with the guide. Because the activities are "self-guided," you may be able to do many of them on your own as long as you have access to a computer on the Internet. Work in a spirit of exploration; feel free to push beyond the limits of the material provided here, and share your discoveries with other students and teachers.

If you are an interested adult, no longer in school but still wanting to know more about how to make use of the Internet, we hope you will enjoy this exploration as well. While you may choose to skip the exercises, you may nevertheless find yourself wondering about the questions. Your search for the answers will open doors while reinforcing the lessons of this guide.

Acknowledgments

The authors would like to thank the Space Environment Laboratory for its support for this project. The staff were enormously helpful in completing this project. Many thanks go to the NOAA Office of Educational Affairs for principal funding, especially Joan McKean and Winnie Agy for their efforts to ensure that the project was supported. We also give special thanks to Tony Tafoya and the EEO Office in Boulder, Colorado, for timely and critical support.

We were lucky to have the help of a local teacher, Randy Sachter, who was carrying out a national Annenberg/Corporation for Public Broadcasting Grant to train teachers across the country on the Internet. She provided excellent focus and clarity to our efforts, as did Libby Black of the Boulder Valley Schools. Paula Dunbar of the National Geophysical Data Center provided valuable assistance with the GeoVu data-visualization program.

Rob Wells provided the cartoons that brought "life" to Jane and Sandy. Barbara Poppe was forced to contribute the mice.

The reviews of this manuscript were many and detailed. The authors are grateful to all of the reviewers.

Stan Froseth
3440 Berkeley Ave.
Boulder, CO 80303
(303) 494-7436
sfroseth@nyx.cs.du.edu

Barbara Poppe
Space Environment Laboratory
325 Broadway, Boulder, CO 80303
(303) 497-3992
bpoppe@sel.noaa.gov
# Table of Contents

Introduction ........................................................................................................ 1

Activity 1: Using E-mail, the Essential Internet Skill ........................................ 5

Activity 2: Using Finger to Find Earthquake Information .............................. 13

Activity 3: Using Telnet to Find Space Shuttle Information ....................... 19

Activity 4: Using FTP to Get Current Weather Information ....................... 23

Activity 5: Using Archie to Locate Programs .................................................. 33

Activity 6: Using Gopher to Study the Sun ..................................................... 41

Activity 7: Using GeoVu to Assess Hazards .................................................. 51

Activity 8: Using Mosaic to Check the Winds ............................................... 61

Activity 9: Using Lynx to Study Greenhouse Gases ..................................... 67

The Internet (Term Paper) .................................................................................. 73

- History of the Internet ................................................................................... 73
- Users of the Internet ..................................................................................... 74
- The rules for using the Internet ................................................................... 74
- Scientific information exchange .................................................................. 75
- Computer equipment and software requirements ........................................ 76
- Connection to the Internet .......................................................................... 76
- The future of the Internet ............................................................................ 77

HELP for the Local Technician ......................................................................... 79

- Getting Started ............................................................................................ 81
- Introduction and References ....................................................................... 81
- An Internet account ...................................................................................... 81
- Equipment and software requirements ....................................................... 82
- Three Kinds of Connections ........................................................................ 83
  - Interactive account dial-up connection .................................................... 83
  - Direct connection ...................................................................................... 84
  - SLIP connection ....................................................................................... 85
  - Requesting a SLIP account ..................................................................... 86
Introduction

The Internet has been called the “Information Superhighway” and “Cyberspace,” as though it takes you to a new world. And although you do get the sense of traveling from place to place when using the Internet, it is nothing more than a set of telephone-type connections among computers. Because of the ability to connect computers, software has been written that allows computers to share information. And since much scientific data is already on computers that are connected, the data become available to everyone on the Internet. Of course, there are many interesting things on the Internet, and all are available to you if you have the access, the tools, and the knowledge.

On the Internet ("the Net"), you can do the following:

- send and receive messages,
- discuss issues with groups of people,
- find information on thousands of topics, and
- read about current politics, culture, and scientific research.

This guide is intended to teach you how to use special software tools for the Internet. It makes use of the scientific data produced by NOAA and other government agencies.

A note about writing and using this guide: things are changing daily on the Internet, and locations and sources can vary without notice. The tools, however, are expected to endure in nearly this form; the purpose of the guide is really to embolden you to explore the Net on your own. Once you have achieved independence, no amount of change will deter you.

Making the Connection to the Internet

Gaining access to the Internet is the first challenge to using the Internet. You can either connect via your telephone to an Internet provider (typically a university or a commercial service such as America On-Line) who gives or sells access, or you can be directly connected at your company or school. Books are available to help you find a connection and hook up your computer, and this guide provides some references and basic information in the Help section. We will assume that with this Help section you can figure out how to hook up and install the necessary communications hardware and software.

Understanding the Connection

There are two different ways in which you might connect to the Internet: direct connection and dial-up connection. If you are working in a big organization with lots of computers, you may have a direct connection. If you are working at home or in a school that’s just getting on the Internet, you most likely will be using a dial-up connection.
Dial-up connection

If you are using a dial-up connection, your computer must be set up to use a modem (refer to the Help section). You will run a communications program on "your computer." The Internet tools that are described in this guide will be UNIX commands that will run on the "host computer," and they will be configured for you.

Direct connection

Using this configuration, "your computer" will be a UNIX machine (but it could be a Mac or PC running Internet tools). We will describe UNIX commands in this situation, and reference to the "host computer" will mean your computer. Generally, your system administrator will take care of setting up these tools and the connection. This is the best configuration to use, but it requires more set-up.

Direct connection using a Host

Even if you have a direct connection, you may find it easier to begin by using a host computer for your Internet tools and services. The services may include an account that holds your e-mail and other files; this is especially useful if your Mac or PC is not limited to your exclusive use. The host computer is assumed to be a UNIX machine that has all the Internet tools installed. You will need an account on the host computer.

The terms "your computer," "host computer," and "remote computer" all have special meanings and are used very carefully in the guide. Refer to the above diagrams for clarification as you read.
Essentials

To use the Internet, you'll need to come prepared with at least a minimum set of computer skills. If some of these tasks appear too difficult for you, ask someone to help you. Getting help with your computer is a great way to get to know new people!

You (or someone working closely with you) should be able to:

- start your computer,
- use a mouse,
- run common software programs,
- open and save data files on the hard disk and on diskettes.

Conventions

Before you get started, please take note of the following conventions used in this guide:

- The names of computer programs are printed in **boldface**.

- Most Internet programs use lower-case letters for names, but be alert for upper case. It matters in some instances, so follow the examples carefully. Correct spelling always matters.

- PC refers to an IBM-PC compatible computer running MS-DOS or Windows. Mac refers to an Apple Macintosh computer. UNIX computer refers to any of a number of manufacturer’s workstations running some version of UNIX.

Different type faces are used to describe your interactions with your computer.

- Text that you type are **bold**.

- The computer’s responses are in *italics*.

- A command for which you supply a name is in *italics*. Substitute the correct name.

- Keys on the keyboard are noted in angle brackets. The `<ctrl>` key is held down while you type the next character (x, in this case).

- Menu items and select buttons are in square brackets. Menus may be on the screen or pulled down from the menu bar at the top of the screen. [File ▶ Quit] means pull down the file menu and choose quit. [GO!] means click on the GO! button.

- "Double click" means use the mouse to click twice (rapidly) on something.

- Instructions are noted in regular type.

**Space Environment Laboratory**

10
Introduction

Internet Activities Using Scientific Data

About the Questions
Questions are rated with numbers in diamonds (1), which rank the questions from 1 (easy) to 4 (very involved). They are designed to get you to look closely at the data, and to learn how scientific questions are answered. Response sheets are included in the back of this guide to help you work through the problems. Some people find it useful to scan the questions before starting the activity.

NOAA's (and other) Data
An important part of the mission of NOAA (National Oceanic and Atmospheric Administration, part of the Department of Commerce) is to describe, monitor, and predict changes in the Earth's environment. This involves making physical measurements, and also storing, interpreting, and disseminating the resulting data. NOAA uses the Internet to let people know what data sets are available and how they can be obtained. NOAA provides data in many different formats including printed pages, computer tapes, CD-ROM, and online. Here, we are primarily dealing with the online format: data that you can get directly into your computer via the Internet. The data available include the following:

- satellite images
- weather maps
- information on the solar-terrestrial environment
- information on marine biology
- sea-surface temperatures
- earthquake data
- measurements of greenhouse gases

NOAA's central Internet locator is http://www.noaa.gov. From this location on the World Wide Web, you can access all of NOAA's online data. You can learn how to access the Web in Activities 8 and 9 of this guide.

In addition, NOAA's data are used by many other organizations. For example, Michigan State University has taken satellite images and made them into weather movies. These are updated every three hours, and are available on the Internet.

Also referenced in this guide are data from the U.S. Geological Survey (USGS), the National Aeronautics and Space Administration (NASA), the National Center for Atmospheric Research (NCAR), and several universities. The extent of the total resources available on the Internet is truly unimaginable. These resources are at your fingertips once you learn the basic Internet tools.
Jane Lopez lives in the hills above Los Angeles. She lives with her mother, father, and younger brother, Richard. She’s a high school student who gets pretty good grades. She and her friends are just learning about the Internet.

Jane’s parents have been married for almost 25 years. A friend asked her if she was going to do anything for them on their 25th anniversary. Jane thought it would be a great idea to have a big surprise party, but how could she pull it off? She needed the help of other family members. Richard said he would be willing to throw rice, as long as he didn’t have to dress up. That didn’t help much. Then she thought of her Uncle Josh who lived in San Francisco. He might have some ideas. The big problem would be to get hold of him without making long-distance calls from home.

Today in school she learned about the Internet and that lots of universities were on the Internet. Uncle Josh worked at Stanford University in the physics department. She didn’t know his Internet address, but one of the examples at school gave an address for someone at Stanford.

She asked her teacher, Mrs. Fine, about finding an address of someone on the Internet. Her teacher said that you had to know the address, and that calling or writing the person and asking is usually necessary. Jane felt very disappointed, because this would be tough; she didn’t even know his phone number. Mrs. Fine was concerned that a potential Internet user was backing away, but didn’t know what she could do to help. Just to ease the situation, she asked Jane who she would like to contact. Jane said her uncle, Josh Salem...he works at Stanford in the physics department...she didn’t know much more.

Mrs. Fine smiled and said she’d see what she could find. It would take her some time to poke around the Internet, so she told Jane to stop by after lunch and see what she had found. Jane was hopeful but felt she still had a long way to go.

By lunch, Mrs. Fine had her answer. Josh was jsalem@stanford.edu. Jane stopped by and got the address. Great! but now what? Here’s what she did, with Mrs. Fine’s help:
Activity 1–Email

Internet Activities Using Scientific Data

Before you begin

You'll need an Internet account (see "Getting Started" in the Help section). If you have a direct connection, you can skip to the "Login and acknowledge" section.

Get your login name, password, and the dial-up phone number.

Start-up and set-up

Set up your basic computer system. You can find basic information on getting started in the Introduction, and more details in the Help section.

Turn on your computer and run your communications program.

For help on setting up a common communications program, see "Establishing a Dial-up Connection" in the Help section.

Use the appropriate menu to enter the telephone number. If you are using a telephone system that requires dialing a number for an outside line, include that number with the telephone number, separated by two commas. The commas tell your communications program to pause for 4 seconds after requesting the outside line with the initial "9".

Enter phone number 9,555–1237 (for example)

(If you have "call waiting," begin your number with the code that disables call waiting; for example *73.)

Use the appropriate menu to set your computer to emulate a VT100 terminal (some programs use VT101 or VT102).

Select [VT100] from menu

Dial-up and connect

Use the appropriate menu item to dial the telephone.

If you have an external modem sitting on your desk, you may wonder what all the flashing lights are about. See "Modem lights" in the Help section.

If you hear a busy signal or see the word BUSY on your screen, wait and try again later. If you hear a series of high pitched tones followed by static-sounding noise and the word CONNECT on your screen, you have connected. You may have to press your <return> or <enter> key several times.

Connect
<return> or <enter> several times.
Internet Activities Using Scientific Data

Activity 1—Email

At this point, your Internet provider may have special instructions that you need to follow before logging in to your Internet account. These generally allow you to navigate through a special “terminal server” computer to the machine that you have been assigned to. If necessary, follow those instructions now.

Log-in and acknowledge

Your host computer will ask you to enter your login name and password. You should type these, following each with <enter>:

- login: your_login_name
- password: your_password

You will not see your password on the screen as you type it; the characters are not echoed for security reasons. If you make a mistake, go through the login procedure again.

Who needs a secure password, anyway?
Remember that you are connecting to other computers, and they can be damaged in your name if your password is used by someone in an irresponsible way.
A safe password:
- is not a word in the dictionary
- has a number or punctuation in it
- is 7 or 8 characters long

If you are successful, the host computer will usually send you a welcome screen. The format of this varies.

Some computers will ask you what type of terminal you are using. Enter VT100. Many Internet computers have this as a default, so you just need to press <enter>.

You should now see the host computer’s standard “prompt.” Prompts look slightly different on different computers. The prompt used in these activities is a single > character. This is the computer’s way of telling you that it is waiting for you to type something.

At this point you can type in the name of any program that you are authorized to run on your Internet computer.

WELCOME

> program_name
Using a mail program to send mail

The example here has you send a message to the authors of this guide. Any message will get you a "form letter" response from us, but we will be able to read your message at a later date. So tell us about yourself.

Different computers have different mail programs. Here are the commands for three common ones.

You can use pine, elm, or mail to send e-mail messages: pine is the preferred program; elm is a good second choice. Once you have determined which e-mail program you will use, stick with it. To start your e-mail program, just enter the appropriate program name.

Note that you can send a carbon copy (CC) of your message to someone else (or to yourself to verify the mail). You can also send your message to several people...just put each of the e-mail addresses on the To: line, separated by commas.

After you have finished entering the preliminary information, your mail program will give you a blank editor screen. An editor is a simple text processor that lets you compose a message. Pine uses the pine composer; elm usually uses either the pico or vi editor, and mail simply allows you to type in your message one line at a time. Any of these editing methods will work for you; however, vi is notorically unfriendly. If you get a row of tilde characters (~) down the left side of your screen, you are in the vi editor. The Help section (see "UNIX Editors for E-mail") will show you how to escape from vi and change your editor.

Hi,

I'm in 12th grade and am just starting out on the Internet. So far, it's OK.

I really want to be playing games on this computer.

George

After you have typed in your message, exit from your editor and send the message.
Exit from mail

When you are done with mail, quit. (You may not want to do that right now). Note that in mail, you will automatically exit your mail program after you send a message.

(pine) (elm) (mail)
q q q (some exit automatically)

Reading mail

If there is mail for you, you will see it when you start your mail program.

Select the message you want to read by typing its number or using the arrow keys.

(pine) (elm) (mail)
pine elm mail
I (index)
1 or ← 1 or ← 1
<enter> <enter> <enter>

Message will appear on the screen
<spacebar> to scroll, if needed

Scroll through the message to read it.

Reply to a message

You can reply to an e-mail message very easily. Make the message you want to reply to your “current message” by reading it or highlighting the number.

(pine) (elm) (mail)
highlight or display the message
Then enter the command to reply.

Then enter the command to reply.

r r R

The mail program will ask you if you want to include the original message.

y y (doesn’t ask)

Your editor will start, and you can add your own responses to the original message. The > symbol indicates the original message in your response message.

> Message
> that you
> receive
Message that you type

To send your reply, exit from the editor just as you did when sending mail.

<ctrl>x <ctrl>x <ctrl>d
y s
q q
Activity 1—Email

Include a file in a mail message

If you have written a letter in an editor and want to send it instead of retyping it, you can send it as a file. While you are composing your message, type the special command to insert the file into your message.

If your computer can run several programs in separate windows, you can also try to copy a letter from your word-processor window and paste it into your communications window.

(pine and elm with pico) (mail)

<ctl> r file_name ~r file_name

(must begin in column 1)

Try other commands

There are several other useful commands in the mail program:

(pine) (elm) (mail)

List all messages i (automatic) (automatic)
Delete old message d d d (after reading)
Undelete message u u u (after reading)
Save a message as a file s s s file_name
List all the mail commands ? ? ?

Addresses

Let's look at test_email@sel.noaa.gov: The address reads from the specific to the general, like a postal address; that is, if we start at the right:

gov government
.noaa the organization or agency
.sel the computer or group name
@ separator
test_email person’s name (sometimes a function name, as this is)

Often the person's name is a first initial and last name up to 8 characters. This is not always the case, however.

Some common domains:
gov government
org non-profit organization
com commercial
edu education

Internet addresses are constructed in a very systematic way, because the network is constantly growing, and the system allows the Internet routers to find new addresses easily.
Send to a friend

Do you have a friend that is also learning how to use the Internet? Send mail to them now. If they have the same domain name as yours, you may only have to type their e-mail name.

Logout

To exit from your Internet account, enter logout. If you are using a dial-up connection, the host computer should hang up the phone. You should also choose "hang-up" in your communications program. Then quit from your communications program.

> logout (or exit on some machines)

hang-up

quit (or menu out)

Questions

1-1. What organization responded to your test e-mail message?  
1-2. Where is the computer that returned your message (city and state)?  
1-3. Send another message and this time make an intentional error when you type the e-mail address. What happens?  
1-4. What is different about communicating with e-mail rather than person-to-person?  
1-5. Is it easy for someone to forward your mail to someone else? What implications does this have?
Netiquette

A message that is sent to a friend can very easily be forwarded to another friend and eventually may end up being read by all sorts of people. If you have written anything you would not want someone else (a teacher or another student) to read, don't send it via e-mail.
Several days later, Jane was asleep when the alarm went off and she hit the snooze button for seven more minutes of sleep. She found it was hard getting out of bed so early, but she had to get up to let the family's new puppy out and then play with her before getting ready for school. She was partly awake when she thought she felt the bed sway. It wasn't much, and she had just begun to think about earthquakes when it stopped. Was it an earthquake or just the wind? Well, she had to get up for school.

Sandy, the puppy, was thrilled to see her, maybe more than usual. Jane thought she was acting differently and remembered hearing her whimper early this morning. When she went outside Sandy raced around sniffing at everything. Jane had to wait a long time until Sandy settled down. Jane thought this was interesting, because animals often act differently around the time of an earthquake.

No one in the house or on the bus seemed to know anything about Jane’s earthquake. She wasn’t imagining it! She thought she’d check out a few facts about earthquakes and find out if there had been one near enough to be felt in her area. She knew bigger ones could be felt further away. Maybe this one was big and far away, or maybe it was a little one close by.

If there had been a big earthquake far away, the news would probably have reported it; you always heard about the big ones. So Jane decided that it would have to have been a small earthquake that not many people noticed. She wondered if the Internet could tell her about recent earthquakes.

Mrs. Fine had recently taught the class about some simple Internet tools: **finger** and **talk**. She told Jane after class that they could easily find out about earthquakes by using the **finger** command. The National Earthquake Information Service in Golden, Colorado, has a listing on the Internet.

Jane had planned to call up the information during her free period, but an e-mail from her uncle required her attention. She really needed to have a conversation with him. Jane decided to use **finger** see if Uncle Josh was on his computer and then **talk** with him. She could look for earthquakes later.
Activity 2—Finger

Internet Activities Using Scientific Data

Login and read information

Login to your Internet account. (If you haven’t done that yet, see the description in Activity 1.)

The finger command

The finger command gives information about people on Internet computers. NOTE: not all computers run this program or have information about their users available.

At the > prompt, enter finger. It shows everyone who is logged in to your host computer.

> finger

Try fingering a specific user on your host computer.
You can name someone whom you know uses that computer, or someone who is logged in right now.

> finger user_name

Questions

2-1. What kind of information can you get on a user with finger?

List all people currently on a system

Before using talk, described on the next page, you will want to use finger to find out who is on the Net, or if a specific person is on the Net. Specify that person’s e-mail address. The resulting display will show if the person is logged in.

If you want to see a list of all of the people connected to a remote computer, you can use the domain name with the finger command.

(Some Internet sites have disabled this command for security reasons. If you don’t have much luck with this, skip ahead.)

> finger sfroseth@nyx.cs.du.edu
(or try a user name and address that you know)

> finger @nyx.cs.du.edu

Questions

2-2. Do you get different user information from different sites?
If finger worked on all computers, (and then could look at all computers in a domain), we would have the beginnings of a Telephone Directory service. Unfortunately, it doesn't. You may find that some computers respond with an alternative way to find out about users (on a menu, say, using another way to connect to the computer server).

If finger works for your local system, you will enjoy seeing if your friends are on. If it doesn't, you can at least try the remote location we suggest for earthquake data.

Real-time conversations with talk

The UNIX talk command enables you to "talk" to someone who is logged in to the Internet at the same time that you are. The talk program is probably available on your host computer. Direct connections or SLIP connections may offer similar programs; ask your system administrator.

If you think a person that you want to talk to may be on the Net, give it a try. (To talk to someone on a different host computer, both host computers must be set up to talk externally by the system administrators.)

After you give the talk command, your screen is divided into two windows; the other person gets a message saying that you want to talk and telling how to respond.

If the other person wants to talk, he uses the talk command and the conversation begins:

> talk jsalem@stanford.edu

Message from TalkDaemon:
talk: connection requested by jlopez@lasd.k12.ca.us
talk: respond with: talk jlopez@lasd.k12.ca.us

> talk jlopez@lasd.k12.ca.us

[Connection established]
Hi, Uncle Josh...are you there?
Good, I was glad to see that you were on the Internet, and I was wondering if you could help me to set the date!
Okay

Hi, Janet! Yes, I'm here, just a little slow on the keyboard today...
Good idea, let's settle it right now. Let me get my calendar;
wait a minute...
Ending the conversation

Both people can type at the same time. Either person can end the conversation by pressing `<ctrl>c`:

If the other person does not answer your talk request, your host computer will keep trying. You can cancel this process with `<ctrl>c`.

<ctrl>c (to end)

<ctrl>c (to cancel)

Turning talk off

If someone has tried to talk with you on your computer, you’ve probably noticed that the request for a conversation appears on your screen, right in the middle of your work! Sometimes you may want to prevent that from happening.

To prevent incoming messages while you are editing a file or doing other important work, use `mesg n`.

To receive incoming messages, use `mesg y`.

<table>
<thead>
<tr>
<th>DATE (UTC)</th>
<th>TIME</th>
<th>LAT</th>
<th>LON</th>
<th>DEP</th>
<th>MAG</th>
<th>Q</th>
<th>COMMENTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>94/09/13</td>
<td>10:01:33</td>
<td>6.93N</td>
<td>76.67W</td>
<td>33.0</td>
<td>5.7M</td>
<td>A</td>
<td>NORTHERN COLORMIA</td>
</tr>
<tr>
<td>94/09/13</td>
<td>10:53:33</td>
<td>38.72N</td>
<td>119.69W</td>
<td>5.0</td>
<td>3.0M</td>
<td>A</td>
<td>CALIFORNIA-NEVADA BORDER REG</td>
</tr>
<tr>
<td>94/09/13</td>
<td>11:45:57</td>
<td>38.84N</td>
<td>119.55W</td>
<td>5.0</td>
<td>3.9M</td>
<td>A</td>
<td>CALIFORNIA-NEVADA BORDER REG</td>
</tr>
<tr>
<td>94/09/13</td>
<td>12:22:13</td>
<td>21.96E</td>
<td>114.30E</td>
<td>31.0</td>
<td>5.5M</td>
<td>B</td>
<td>VANUATU ISLANDS REGION</td>
</tr>
</tbody>
</table>

Finally, Jane was ready to get to the earthquake problem. All she needed was a recent list of earthquakes to see if one had occurred near her home that morning. It turned out to be easy to net the information using the `finger` command.

Finally, Jane was ready to get to the earthquake problem. All she needed was a recent list of earthquakes to see if one had occurred near her home that morning. It turned out to be easy to net the information using the `finger` command.

Requesting data

Using the `finger` command, request the seismic information.

`> finger quake@gldfs.cr.usgs.gov`
Questions

2–3. Find the strongest quake in the last few days. Hint: Look at the magnitude column (MAG).

2–4. Find a quake that is in the southern hemisphere.

2–5. Mark the location of each quake or tremor on a map of the world. Where is most of the activity in the last few days?

2–6. Check the activity every day for a week, plotting each new record. What patterns do you see?

2–7. Get a geography book that has a map showing the Earth’s major tectonic plates. Draw the plate boundaries on your map. How do the boundary lines relate to recent seismic activity?

2–8. Jane’s latitude and longitude are approximately 34° N, 118° W. Was there a small earthquake near her home today?
Netiquette

When using e-mail or talk, save the use of upper case letters for emphasis (such as when you are REALLY EXCITED about something). You can show that a comment is intended to be funny with the symbols

:-)

(turn the page sideways to view).
J

ane had not told her parents much about her work on the Internet. She didn't want to tell them she had been conversing with Uncle Josh because that would lead to other questions. The plans for the party were progressing nicely and so far the secret was safe. But she did tell them that she had been using the Internet to find earthquake data and stuff like that.

Her mother liked to hear what Jane was doing in school, and she was curious about the Internet. Boy, she'd be excited if she could write to her brother in San Francisco and get an answer the same day, thought Jane! Her mother was a “family” kind of person, and Jane looked forward to telling her about e-mail and talk after the party!

Jane's father was also interested in the Internet. His small company didn't have a connection, but it had a small research contract with NASA for biological research (small for NASA, that is, but very important to Jane's dad). Lately, he had been pretty excited about the project that he had been doing: studying seed germination in a zero-gravity environment. An experiment designed by his company was scheduled to go up with the next NASA space shuttle mission, due to launch soon.

This morning at breakfast, Jane's dad asked her if she could use the Internet to find out if the launch was on schedule, and if his company's experiment was included in the shuttle cabin's payload. Wow! People are sure expecting me to find out anything and everything these days, Jane thought. She almost blurted out that she didn't know how to get the information, but since her father seemed so interested and so confident that Jane could do it, she just smiled when he kissed her good-bye and said she'd try.

Still, she grumbled to herself on the way to school that everyone was thinking of her as some kind of expert even though she wasn't. Why me?! Her resentful feelings began to melt away when in class she picked up one of the Internet "Yellow Pages” books on the shelf above her computer and looked up NASA. Sure enough, there was a computer called Spacelink at the Marshall Space Flight Center. The book said that she could use a telnet connection to the computer, which would let her have a guest account on the computer. What she found out was pretty neat, too; her dad was going to be pleased.
Connect to Spacelink

The telnet program is available on virtually all host computers that are on the Internet. It is particularly useful because it allows you to connect to other computers, login, and use them. (Not all computers on the Internet allow "guest" telnet, however.) When you are using a telnet connection, the remote computer will ask you for a login, and sometimes a password. Some computers are set up with special login names such as "guest," which require no password.

Login to the Internet on your host computer. Run the telnet program and ask it to connect you to the Spacelink machine.

The Spacelink computer is set up to be very friendly to guest users; it allows you to select options using a menu. Recent space missions are described under the "Spacelink.Hot.Topics" menu item. Select it by using the arrow keys and <enter>, or by typing the number of your selection and <enter>.

Because Spacelink is set up to communicate with keyboard commands, your mouse won't work.

There will be a listing of recent events of interest at NASA, and several of these will be shuttle missions. Select the latest:

Information on the current mission can be found in the Press Kit:

The Press Kit contains lots of information that summarizes the shuttle mission. Use the table of contents at the beginning to locate information about experiments that will be done in the cabin. Scroll down and read about the experiments.

When you have finished looking at the Press Kit, press u to return to the menu. Then select the launch information menu item. You will see a series of launch bulletins (with dates) that describe progress and preparations for the shuttle launch.

(login to the Internet on your host)
> telnet
telnet> open spacelink.msfc.nasa.gov
login: guest

[Spacelink.Hot.Topics]

[Current.Shuttle.Mission.STS-68] (or Recent...)

[Press.Kit]

(scroll to information about cabin experiments)

u

[Launch.Information]
(select the desired bulletins to get information about the status of the shuttle launch)
When you are done, press q to quit, and then quit from your telnet program.

q

Really quit (y) <enter>
telnet> quit

Questions

3-1. What experiments will be done in the cabin on the next space shuttle mission?

3-2. What delays (if any) have occurred in the launch schedule?

J

ane called her dad at the office and told him the shuttle information. He seemed to be delighted to have the latest news, and he was glad to see that his work was going to be a part of the space shuttle flight. He certainly had talked a lot—every night at dinner—about his experiment and what he might discover. By now, even Jane was getting interested in the idea of being weightless. She wondered what it might be like to live in an environment without gravity. She decided to use her computer to look up library books about weightlessness. Making the connection to the library was easy: Mrs. Fine had used telnet with a computer class to look up some books at the Los Angeles Public Library, and the Internet address was still on the board in the classroom.

Library Systems

There are hundreds of library systems connected to the Internet, and many are linked together. If you can get into one system, you can often “hop” from system to system to find what you want.

Login to the Internet, run your telnet program and request a connection to pac.carl.org. It’s a service of the Colorado Alliance of Research Libraries:

> telnet
telnet> open pac.carl.org

Enter Choice: PAC
Select line#: 5 (specify VT00 terminal)

[4. Other Library Systems]
[43. CARL Corporation Network Libraries – Western U.S. (MENU 2)]
[131. Los Angeles Public Library] (connects to LA Public Library system)

Press <RETURN> to start... <enter>

[1. Los Angeles Public Library’s Online Public Access Catalog]
You are now connected (via telnet) to the Los Angeles Public Library, and you can specify that you want to do a word search for “weightless:”

You’ll probably get two lists, one for “weightless,” and another for “weightlessness.” Select the first list by entering 1, and then investigate the books on the list. You’ll find that it’s easy to use the menus; just follow the instructions at the bottom of your screen. When you are done looking at the first list, look at the second one:

Enter Command (use //EXIT to return HOME)>> W (for Word search)

> weightless

Enter line numbers to select items . . . > 1
(investigate the list of books)

Enter line numbers to select items . . . > 2
(investigate the list of books)

Finally, when you are done, exit from the Los Angeles system, and then from the Colorado system:

//exit (returns to pac.carl.org)
You’re now back at home...press <RETURN> to continue> <enter>
//exit (returns to your telnet program)
telnet> quit

Questions

3-3. Find the title of a book at the Los Angeles Public Library that is about experiencing weightlessness on the space shuttle.

3-4. What information would you need to copy down in order to find the book when you go to the library?

3-5. Find a story by Isaac Asimov about being weightless.

If at any time you get “stuck” on the Internet and none of the exit commands seem to work, as a last resort, turn off your modem and exit from your communications program. Then turn the modem back on and start over.

Netiquette

Exit from a remote telnet connection (or any other Internet connection) as soon as you have finished with your work. This will release an access point that someone else can use.
Friday! Tomorrow Jane and some friends were going to the beach or to the desert. So far, they couldn't decide where they would go. Jane offered to check out the weather because they didn't want to go swimming if it was too cold, or to the desert if it was too hot. If it was cold on the beach and hot in the desert, they would just hang out at the Mall. Living in the hills as she did, Jane was often surprised to see that the weather just a few miles away could be so different from that at home.

The weather man had said tomorrow's weather would be "more of the same." She decided to try to find out the temperature today in San Diego and in Las Vegas.

Jane tried to get Mrs. Fine to help her, but she was out of the building that day. It wasn't until the end of the day that Jane ran into Mr. Goodman. He was a parent who volunteered in the computer lab, and he knew a lot about the Internet. After school, Jane sat down with Mr. Goodman and learned how she could find the answer to her questions.

The initials ftp mean "file transfer protocol," Mr. Goodman was saying. It's a standard program that is used to move files around on the Internet. If Jane had wanted to use her "low-tech" dial-up connection at home, she could get the host computer to run ftp. But at school, she had a direct connection and ftp on her computer—virtually all computers on the Net have it—so the connection to a host computer wasn't necessary.

Mr. Goodman seemed to be enjoying his explanation, and pretty soon Jane thought this might turn into a week-long project instead of a 5-minute question. But he was making it easy for her to understand, and she could see how useful ftp could be for big data files she might need in future projects. Still, it was Friday afternoon and Jane wanted to be done with "school" for the week. She thanked Mr. Goodman, and went to an open computer to see if she could settle the weather question that would decide where they would go tomorrow.
Running ftp

Login to your host computer.

Run your ftp program.

The program should respond with a special prompt.

FTP is now waiting for your command. Remember that, like many programs on Internet computers, you can find out more about a program by typing ? or help.

Connecting to another computer

Ask your host computer to connect to another computer:

ftp> open ncardata.ucar.edu

The computer at the National Center for Atmospheric Research (NCAR) will respond with a welcoming message, and will ask you for a login name and a password. Out of courtesy, use your e-mail address as the password.

ftp> login: anonymous

ftp> password: jlopez@lasd.k12.ca.us

You have established an “anonymous ftp session” with the NCAR computer.

Anonymous ftp

Anonymous ftp lets you login to a computer using a login name of anonymous (many computers also accept the login ftp). Usually the password that you enter doesn’t matter, so anybody can login to that site. You then have restricted access to the system so you can’t do any harm. You should use your Internet e-mail address as the password.

You need to know how to get around in the directory structure of these remote computers. The commands used to navigate a directory structure with ftp are similar to UNIX commands. You can get help on these in “UNIX” in the Help Section.
Navigating on the remote computer

When you first connect to another computer using ftp, you'll want to know where you are in the directory structure. You can find out where you are at any time by entering `pwd` (print working directory).

You can also check out what's in the current directory by entering `ls -l` (or `dir` on some computers).

Three ways to control the listing

If the directory is a large one and some of it scrolls off your screen, use the "scroll back" feature of your communications program to look back at the top part of the list.

If you don’t have scroll back, press the `<pause>` key on your keyboard to stop the display while it is scrolling up. Press any other key to restart the display.

On some systems, you can use `<ctrl>` `s` and `<ctrl>` `q` to stop and start the display.

Finding the data

Change to the directory that has the weather information and check out what’s in it.

You’ll get a list of the files and subdirectories in this directory. The one that you are after has some simple weather information for cities in the western United States.

Getting the data

You are ready to get the file:

The NCAR computer will send the file to your host computer. This file is not very large; the transfer should take only a few seconds.

The file `USwest_city.obs` is now on your host computer. You can get other files with the `.obs` extension now, if you wish. Then disconnect from the remote computer and quit from the `ftp` program.
FTP files on a direct-connect computer
If you are running ftp on your computer with a direct or SLIP connection, the file is now actually in the machine in front of you; you can use a word processor program to open and read it.

(Note that if you are using a PC, the filename USwest_city.obs has been converted to a legal MS-DOS filename, something like uswest_city_. This happens because the UNIX file name is too long for MS-DOS to handle.)

> word uswest_city_ (for example)

Where did that file go?
Sometimes the hardest part of working with computers is finding where stuff is, especially if a program like ftp puts it somewhere without asking you or telling you where.

If you are running ftp on your computer, your ftp program will usually have a menu selection that allows you to control the destination of files that you get. After the file is transferred, you'll find it in the destination directory (or folder on a Mac).

If you are running ftp on a host computer, the file will go to the directory on your host computer that was current before you started ftp. When you quit from ftp, you'll find the file in the current directory.

FTP files on a host computer
If you are using a host computer to run ftp, remember that the file you got is still on the host computer.

You now have two choices:

First choice: you can display the file using the UNIX more program. The contents of the file will be typed on your screen and you can read it! This works only for text files.

>more USwest_city.obs

Second choice: you can send the file to your computer's disk ("download"). Most Internet computers can do this using the kermit program. Use the appropriate file transfer menu on your computer (for the MS Windows Terminal program, it's Receive Binary File) to start the transfer.

>kermit -s USwest_city.obs (on the host)
[Receive Binary File] (on your computer)

Check “Modem file transfers” in the Help section.
Read the file you received

You should now be able to read the contents of the weather file, either with your word processor, or with the more program.

Read a file directly

If you want to look at a file that is on a remote computer without actually transferring it anywhere, you can (with some versions of ftp) list the file on your screen. Good examples of what you might want to read are readme or index files. You can also look at short data files. Here is how:

Using ftp, connect to the remote computer, navigate to the directory you want (cd), and look at the contents of the directory (ls -l).

Say you want to see the weather file from above. Use the get command with the more option. Note the space before the I character. The "vertical bar" will cause the file to be sent through the more program, which will send it directly to your computer screen, one page at a time. A <spacebar> will bring up additional pages.

Establish anonymous ftp connection
(run ftp, open, login)

ftp> cd directory_name
ftp> ls -l

ftp> get USwest_city.obs I more

<spacebar> (to scroll if needed)

Questions

4-1. What is the weather like in San Francisco today?

4-2. Jane had to call her friends that night to tell them what the weather was going to be and where they were going tomorrow. Her choices could be diagrammed as shown. What did they decide to do based on today's weather in San Diego and in Las Vegas?
It was getting on towards 5:00 PM, and Jane wanted to be home. But she kept wanting to do "just one more thing." Richard was always so impressed by astronomical happenings. She thought it would be really neat to bring him home some pictures from the Internet—printed right there on her local printer. She called home and said she'd be a little late. She promised to be there by dinner time, and asked Richard to kiss the puppy for her. ("Right!" Richard had said, sarcastically.)

In May of 1994, an annular eclipse of the Sun was visible in North America. An annular eclipse is one where the moon doesn't quite cover the Sun, leaving a thin, bright "annulus" or ring. There are views of this event from several different locations in the country. She wanted to choose the best one to print. In the process she stumbled across some iceberg data. Richard would love it!

### Pictures of the annular eclipse

When transferring pictures and other non-text files using **ftp**, you'll need to tell the remote computer (the one with the picture) to use a binary transfer. This time you'll connect to NOAA's National Geophysical Data Center.

```
> ftp
ftp> open ftp.ngdc.noaa.gov
ftp> bin
```

While you're in the root directory, check out the README file.

```
ftp> get README.txt | more
```

Change to the **STP/ECLIPSE** directory and look at the `read_me` file.

```
ftp> cd STP/ECLIPSE
ftp> get read_me.txt | more
```

Now use `get` to transfer the two picture files, `ec_boul.gif` and `ec_holo.gif`. You can close the connection and quit from **ftp** when you have finished.

```
ftp> get ec_boul.gif
ftp> get ec_holo.gif
ftp> close
ftp> quit
```

If you used a host computer to **ftp**, get the files to your computer. The option `i` tells **kermit** to keep the files in binary form and option `s` tells **kermit** to send the file.

```
> kermit -i -s ec_boulder.gif
> kermit -i -s ec_holo.gif
```

### View and print the pictures

After you have the picture files on your computer, you can view the pictures with a viewer program. If your viewer has printing capabilities and you have a graphics printer, you can make a printout as well. Most commercial "paint" programs can display and print .gif images.
As an example, assume that you are using a PC with Windows, and you have the LView 3.1 image viewer program. (You can get it via anonymous ftp; see the Help section.)

Run the viewer program, and open the file that you want to display. If you have a graphics printer, select the Print menu item.

Questions

4-3. How are the two views of the 1994 annular eclipse different? Where were the photographs made?

4-4. Find a map of the path of the eclipse. What part of the United States saw the annular eclipse?

Tracking an iceberg

In 1983, the U.S. Coast Guard placed radio beacons on several icebergs to track their movement in the ocean. The beacons were monitored by satellites overhead. One of the icebergs was called “02625.ndc,” after the radio beacon that was used.

You can find information about this project at the same site as the eclipse data. You’ll need to be resourceful to find this information. Use dir right away to locate a likely directory. Look over the information in drifters.doc. Then look at the data file, 02625.ndc. Don’t get discouraged. Look for patterns and you’ll soon discover how to read the data.

(login to your Internet computer)

> ftp
ftp> open ftp.ngdc.noaa.gov
ftp> dir
ftp> cd Snow_Ice/Iceberg/Drifters
ftp> get drifters.doc | more
ftp> get 02625.ndc | more
ftp> quit

You will see many lines of data. Here is a single line and how to interpret it:

```
156 C02625533336N0544424W8303242255000 001
```

156 The data file number (ignore)
C Means this is a data record
02625 The number of the radio beacon
533336N The latitude position of the beacon: 53 degrees, 33 minutes, 36 seconds North latitude
054442W The longitude position of the beacon: 5 degrees, 44 minutes, 42 seconds West longitude
830324 The date: 1983, March 24th
2255 The time in twenty-four hour format: 10:55 p.m. Greenwich Mean Time
000 The sea temperature (not used for this project)
001 The observation number: This is the first after launch
Activity 4–FTP

Questions

4–5. Where in the world was the “02625” iceberg? Plot its initial location on a graph.

4–6. On the graph, plot the path of the berg while it was under observation.

4–7. Determine the approximate fastest speed of the berg in knots.

Good Sites

After you’ve used the Internet for a while, you’ll probably have your own favorite anonymous ftp site, or a list of them. New users of the Net often wonder “How do I find out where things are on the Internet?”

As you move about on the Net, you may encounter various “ftp lists” that have been compiled by organizations and individuals. These range from very general to highly specialized. Of course, you may grab copies of any of these lists; some of them are updated often, others may be out of date.

We have included a short list of Internet sites on the next page. There are also several books available that contain nothing but lists of Internet information sources. Check your local bookstore.

Netiquette

Try to transfer large files during non-business hours. Most Internet computers used in business and at universities are doing other work during the day.
Internet Sites

Here is a quick reference to the sites we point to in this document. On the flip side are some others. Note that they are a mix of ftp, gopher, and www sites. By the time you finish this guide, you'll know how to get to them all.

Activity 1: NOAA Space Environment Laboratory e-mail reflector  
Activity 2: USGS Earthquake Report  
Activity 3: NASA Spacelink  
   Colorado Alliance of Research Libraries  
Activity 4: National Center for Atmospheric Research  
   National Geophysical Data Center FTP  
Activity 5: Archie server for telnet  
   Archie server for e-mail  
   Washington University software archive  
   UNIX software archive  
Activity 6: Gopher public access client  
Activity 7: National Geophysical Data Center Gopher  
Activity 8: Purdue University Weather Center  
Activity 9: NOAA Environmental Information Services  
   NOAA Climate Monitoring and Diagnostics Laboratory  

Feel free to write down good sites that you find or hear about:

---

---

---
Internet Sites

National Oceanic and Atmospheric Administration (NOAA) home page
University of Illinois public gopher (good central ftp site locator)
EINet Galaxy: WWW sources for science, math, other
Catalog of WWW resources
NCSA Internet Resources Meta-Index
JPL Education Archive
NASA Archive
NASA news
Science Education Archive
Stanford software archive
Washington University software archive
NSF Science and Technology Information System
National Education Bulletin Board (with Supercomputer access)
Federal Government information
U.S. Library of Congress
NetFind user lookup
"Uncover" periodical database
MidContinent Regional Education Laboratory
MIDI music archive lists
Annenberg Science and Math Initiatives
GLOBE Program (Global Learning and Observations to Benefit the Environment)
Boulder (Colorado) Community Network

Xerox Map Viewer
Cleveland Freenet (with access to other community networks)

Education Library
JASON Electronic Field Trips
NASA K–12 gopher
Wired Magazine
The Rolling Stones

http://www.noaa.gov
telnet://ux1.cso.uiuc.edu
http://www.einet.net/galaxy.html
http://cui_www.unige.ch/w3catalog
http://www.ncsa.uiuc.edu
ftp://pubinfo.jpl.nasa.gov
ftp://explorer.arc.nasa.gov
(finger) nasanews@space.mit.edu
ftp://ftp.bio.indiana.edu
ftp://sumex.aim.stanford.edu
ftp://wuarchive.wustl.edu
gopher://stis.nsf.gov
telnet://nebbs.nersc.gov, login: nebbs
telnet://fedworld.gov, login: new
telnet://marvel.loc.gov, login: marvel
telnet://bruno.cs.colorado.edu, login: netfind
telnet://database.carl.org
gopher://gopher.mcrel.org
ftp://ftp.cs.ruu.nl
http://www.c31anl.gov/Hspeck/SAMI-home.html
http://hpcc.hpcc.noaa.gov
http://bcn.boulder.co.us
telnet://bcn.boulder.co.us
http://web2.xerox.com/hypertext/docs/mapviewer.html
telnet://freenet-in-a.cwru.edu
telnet://freenet-in-b.cwru.edu
telnet://freenet-in-c.cwru.edu
http://seawifs.gsfc.nasa.gov/JASON/JASON.html
gopher://quest.arc.nasa.gov
http://www.wired.com
http://www.stones.com
Activity 5: Using Archie to Locate Programs

Saturday with her friends was really fun, Jane thought; they hadn't wanted to come home. But Sunday, which was supposed to be relaxing was far too busy. She had too much homework, she had to help bathe the puppy (actually, that was fun, although Jane got soaked too), and she had to do other chores and clean up her room. When did she get any time for herself? Monday had come too soon.

For a Monday, though, this was turning out to be pretty good. So far, none of her classes had assigned homework, and she was beginning to think that a few easy evenings might make up for the busy weekend.

Her computer class was usually pretty loose, with each student doing something independently. She had been hearing people say "oh, you can get that program on the Net," but she never knew where. It was only a matter of finding something; Jane already knew how to transfer it with ftp.

Today she had time to explore. Mrs. Fine was back in class, so Jane asked her where to start. With archie said Mrs. Fine. "Archie?" (Where do they get these names, thought Jane.) Mrs. Fine didn't have much time for Jane that day, and went off to help someone else, but she showed her how to start archie, and that was all Jane needed. She found out that archie is a tool that can be used to find other programs on the Net. She wanted to get zterm, a "shareware" communications program, for her best friend to run on her Macintosh at home, and Richard had been bugging her about bringing home some games. If Jane could get these free programs from the Internet, she could "talk" to her friend via their home computers and could learn the new game, hopefully while Richard slaved away with his homework.
Activity 5—Archie

Using archie to find programs

The program archie allows you to search on the Net for files and directories containing a string of characters that you specify in the name. For example, let’s say you are looking for the zterm communications program:

Run the archie program on your host computer. Use the option -s (the s stands for “substring”), followed by the string that you are searching for (could be part of the filename).

If you have a direct connection with the archie program installed on your computer, run archie and enter the string in the search window:

After a pause (possibly several minutes) archie will display a list of the computers (“hosts”), directories (“locations”), and files where the string was found. These computers allow anonymous ftp, so jot down the name of one of the hosts and its directory. Then establish an anonymous ftp connection to get the file.

If you don’t have archie on your host computer, you can run it on a “public-access host” (a computer that allows anyone to use its archie program). Just telnet to archie.sura.net and login as archie:

(Note that we used a shortcut that omits the open command and puts the site address on the telnet line.)

To initiate a search, enter the prog command, after the archie prompt, followed by the search string:

Archie will return a list of ftp computers and directories. When you are done, quit from archie and terminate the telnet connection.

Questions

5-1. Which Internet computer has zterm?

5-2. Use archie to locate a “paint” program for your computer. Which Internet computer has such a program? What is the directory and file name?
Mail your search request

Requests in archie can take a long time to complete. You may want to just submit your request by e-mail and check your mail a few minutes later.

> elm
Send to: archie@archie.rutgers.edu
Subject: prog zterm
(no message)

Getting a game...

There are a lot of games available on the Internet. Let's use archie to find some.

Use one of these three methods to ask archie to locate some computers with games:

1. > archie -s game (using your host)
2. archie> prog game (using archie.sura.net)
3. (send your request to archie.rutgers.edu)

You'll get quite a long list. One of the hosts that might show up is the ftp archive at Washington University in St. Louis. Follow the example below for your computer type.

...for the PC

Get a compressed game program file from one of the ftp sites that you discovered using archie. Then unpack the file and run the program.

First, login to your host computer and make an anonymous ftp connection to Washington University in St. Louis. (Note this shortcut, too, running ftp and giving the address in one command.)

Change to a directory with games for PC computers. Before continuing, you may want to take a look at the index file listing all of the games. Use the <spacebar> to scroll through the game descriptions. When you decide to quit looking at the index file, use <ctrl>c:

Get "Ken's Labyrinth" game in the Epic directory. Because the file is saved in compressed binary form, set the transfer mode to binary before getting the file:

(Feel free to get a different game if you like. This one is chosen for example.)
The file is a big one (almost 900 Kb) so there will be a pause while it is transferred to your host computer. If you don’t have a copy of an unzip program, now is a good time to get one. Change to the directory containing a version of UNZIP.EXE and get the program. Then quit the ftp program:

```bash
ftp> cd /  (takes you to the home directory)
ftp> cd systems/ibmpc/simtel
ftp> get UNZIP.EXE
ftp> quit
```

Transfer ("download") both of the new files to your PC computer. Use the zmodem protocol if your communications package has it or use kermit (see "Modem file transfers" in the Help section). Kermit requires the i option to transfer the file in binary ft. Tn. Remove both files from the host computer. Then end your Internet session:

```bash
> kermit -i -s ken.zip
> kermit -i -s UNZIP.EXE
> rm ken.zip
> rm UNZIP.EXE
> logout
```

### Unzip and run a PC file

Before you can actually use the game, you need to set up a place for it on your computer and then unzip the files. Here, the prompt is your PC’s MS-DOS prompt.

Create a directory on your computer for the game, and one for the unzipped program.

```
> cd\download_directory
> move ken.zip c:\ken
> move unzipped.exe c:\util
```

Change to the game directory and unzip the files. To figure out the command you need to actually run the game, you can check any readme files, or use the dir command to find a file that has a .exe extension. Then run the game by entering the name of the file; the .exe extension is not needed. Have fun!

```
> cd c:\ken
> c:\util\unzip ken.zip
(files unzip into the ken directory)
> ken
(the game starts!)
```

Once everything is working, you might want to save some disk space by deleting the original .zip file.

```
> del ken.zip
```

The game that you got is shareware. That means that if you keep it, you must pay a small fee; registration information is built into the game. For more information on shareware, see the Help section.
...for the Mac

First, login to your host computer and make an anonymous ftp connection to Washington University in St. Louis.

Change to the directory with games for Macintosh computers. Before continuing, you may want to take a look at the games that are available. Use the dir command—note the directory name is game (no s).

login to Intern.: login to Intern.: > ftp wuarchive.wustl.edu
Name: anonymous Password: your_e-mail_address
ftp> cd systems/mac/info-mac/game
ftp> dir

Get the air traffic controller game. Because the file is saved in compressed binary form, you'll need to set the transfer mode to binary before getting the file.

If you don't have a copy of a Macintosh "unstuffing" program, now is a good time to get one. Change to a the directory containing a version of stuffit-expander and get the program. Then quit the ftp program.

If you are using a dial-up connection, transfer both of the new files to your computer. Use zmodem if you have it or kermit (see "Modem file transfers" in the Help section). Kermit requires the i option to transfer the file in binary form. Remove both files from the host computer. Then end your Internet session.

Unstuff and run a Mac file

Before you can actually use the game, you need to expand (uncompress) it on your computer. First, run the stuffit-expander and ask it to expand the air traffic controller game.

The expander will automatically do two conversions. The .hqx file is "binhex decoded" to give a .sit file. Then the .sit file is "unstuffed" to give you the actual game folder. You'll see it on your screen, labelled ATC 5.01 Folder. To save disk space, you can delete (trash) the .sit and .hqx files. Save the stuffit-expander for later use. Now open the ATC 5.01 Folder and double click on the game to run it.

Have fun!
The game that you got is freeware. That means you don’t need to pay for it. However, be sure to read “About Air Traffic Controller” on the Apple Menu. For more information on shareware and freeware, see the Help section.

...for a UNIX computer

First, login to your computer. Before you actually get the game, you need to set up a place for it on your computer. Create a directory on your computer for the game.

Make an anonymous ftp connection to the University of Minnesota.

Change to a directory with games for UNIX computers. Before continuing, you may want to take a look at the games that are available.

```
login to Internet
> cd (to your home directory)
> mkdir chess
> cd chess
> ftp ftp.cs.umn.edu
Name: anonymous
Password: your _e-mail_address
ftp> cd pub/gnu
ftp> dir
```

Get the chess game from the Free Software Foundation. The file is saved in compressed binary form, so you’ll need to set the transfer mode to binary before getting the file.

```
ftp> bin
ftp> get gnuchess-4.0.pl70.tar.gz
( that’s PL70, but lower case)
```

The file is a big one (over 1.7 Mbytes) so there will be a pause while it is transferred to your computer.

Uncompress and run a UNIX file

Unzip the files.

Most UNIX programs require that you compile them for the particular machine that you are using. This is done with a make file. To continue, read the instructions in the make file. You’ll need to make a few changes indicating the directories to be used on your computer, then follow the rest of the directions to compile and run the program.

Once everything is working, you might want to save some disk space by deleting the original .tar file.

```
> gunzip gnuchess-4.0.pl70.tar.gz
(file uncompresses, becoming gnuchess-4.0.pl70.tar)
> tar -xvf gnuchess-4.0.pl70.tar
(files are expanded into suitable subdirectories)
```

```
> cd
> cd chess/gnuchess-4.0.pl70/src
> vi makefile (follow instructions carefully)
   (if you are unfamiliar with vi, use another editor)
```

```
> cd ~/chess
> rm gnuchess-4.0.pl70.tar
```
The game that you got is shareware. That means that if you keep it, you must pay a small fee; registration information is built into the game. For more information on shareware, see the Help section.

Questions

5-3. Describe the game. What is the game's best characteristic?
Netiquette

There are games that can be played on the Net, but be careful that they are played only during allowed hours. There are also pornographic materials on the Net. Accessing or transmitting these is illegal. You are responsible for your use of the Net, and you can find yourself in trouble for inappropriate use.
Jane's class was planning a picnic at a park several miles away from the school. They had earned this outing by turning in what their teacher, Mr. Schultz, said were excellent projects (and all of them in on time!). That must have been a first, because Mr. Schultz was not one to take a day off from class! There were teams working on different parts of the picnic: the food, the transportation, the activities, the music (that was Jane's team); and each team was supposed to do more than just decide things. Mr. Schultz expected his students to research everything and give a report to the class. Think of the poor team that had to research the food, thought Jane! Of course, this couldn't be just a day off. But, hey, at least the day would be fun when it came.

Jane's team knew they had an important project. Her classmates knew music, and they practically lived and breathed the rhythms of the latest hits. They debated whether they could use the radio or should take a boom box and tapes instead. The radio would be most convenient, but they didn't know how the radio reception would be so far out of town. Elvis Jones was on Jane's team, too. He seemed to know a lot about radio. He was a "ham" (in more ways than one, thought Jane). He operated his radio almost every night, talking to people from all over. He said he had talked to someone near the park recently; he'd call them and ask about the radio reception.

Boy, this was going to be an easy project. Elvis would do the research and they would be done with it. The next day, Elvis had found out about the reception; it depended on the Sun and what had happened $1.5 \times 10^8$ km away! Sunspots can affect radio communication and the transmission of electric power. To decide if the radio would work, they would have to find out what the Sun was doing. Apparently, Jane was going to be doing some research, too, but she knew the Internet would be able to give her some information in a hurry.

Mr. Shultz suggested using gopher and veronica (related to archie?), whatever they were. Jane thought this was going to be hard, but Mr. Shultz typed in a few commands and brought up an amazing list of choices. This was like being in a candy store; it was going to take time to look at all the choices. She also realized that she could do this from home on her PC.
Look for gopher

Try running gopher. If you are directly connected, you can just enter gopher at the computer’s prompt, or use the mouse to activate the program. Otherwise, login to your host computer and try entering gopher at the prompt.

> gopher (just to see if it runs the program)

Gopher service

If you don’t have gopher, you can connect (telnet) to a site that will run it for you. The University of Minnesota and the University of Illinois provide free gopher service.

If you are running telnet on your direct-connect computer with a mouse, start the telnet program and use the open connection menu. Enter the name of the computer: consultant.micro.umn.edu and tell telnet to start. (Note that the program you run on your PC or Mac may not be called “telnet;” see “Getting Internet Tools” in the Help section.)

You should get a message from the computer at the University of Minnesota. To login, all you need is a special login name. You’ll then get the gopher menu from Minnesota.

>telnet consultant.micro.umn.edu
(or telnet ux1.cso.uiuc.edu)
[open connection]
consultantanicro.umn.edu
[go]
login:gopher
(gopher menu)

The gopher menu

There are thousands of gopher computers around the world; not all of them have the same main menus, but they are similar. On the main gopher menu, most have some information about the particular gopher computer you are using, or some interesting things about the city, college campuses, etc. Almost all will have a menu item something like this:

This is the menu item that you want: it is your doorway to the gopher world! Enter the number of the item, or use your arrow keys to select the item, and press enter.

Navigating down the menus will be easy. To get back to the previous menu type u (up).
Next, you'll ask the gopher to help you to search using veronica. Among the selections on this menu, you should see two different kinds of searches. One refers to searching directories; the other refers to gopherspace (searches files and directories). Choose one of the gopherspace search options. You will have a choice of servers; choose one that appears to be in your part of the world. (The name of the server will give you a clue; for example, nysernet is a computer in New York.)

When you do a veronica search, you can choose a directory search, or a gopherspace search. Suppose you enter the key word "cheese." A directory search would find all of the directory titles on all of the gopher computers in the world containing "cheese." A gopherspace search would find directories and also any actual documents (files) with "cheese" in the title. As you can see, a gopherspace search is the most complete, but it would require more time, and might give you more information than you wanted.

Making effective key-word searches is an art!

Searches

You now have a field (an empty box) on your screen; you can enter "key words" and the gopher computer will search the titles of all items on all of the gophers for the key words that you request. If you want to search for more than one key word, just enter each one, separated by commas. Enter "sunspot" and let veronica do its search.

After a short wait, you will get a screen with all of the documents on gopher computers that have the word "sunspot" in the title or in a directory name. If the entry ends with a slash (/), that usually means it's a directory. Otherwise, it's an actual data file. One of the search results should be ZURICH_SUNSPOT, a directory:

Select it now. (If you don't see this one on your screen, go back up a few menus and try the search again using another gopher server.)
You should see a list of about 20 files, all of them related to sunspot activity. Select the one titled info.ssn and read a bit about how sunspots are counted. When you are done, press q to go back to the menu.

[info.ssn]
(read file)
q

Where are you?

Where is this information coming from, anyway? Type = to get information on the gopher server that you've contacted. You'll find that the sunspot information is on a NOAA computer.

= host = gopher.ngdc.noaa.gov
path = o/NGDCPublicData/SolarTerrestrial
Physics/SOLARDATA/ZURICH_SUNSPOT

Getting back with bookmarks

Let's say you found a particularly interesting gopher location. You can save it in a “bookmark” file to make it easy to find again. Highlight the menu item (or display the item on your screen) by pressing the arrow keys and type a (for “add”). The Internet address will be saved in a bookmark file, along with a title.

The title for your bookmark will be the menu title (you can change it if you want to).

At any time while running gopher, you can get to one of your bookmarked locations by pressing v (for view). You'll see a menu with all of your bookmarks. Select the one you want and you will immediately go to the location that you saved.

[info.ssn]
a

info.ssn, change to:
[About Sunspot Counting]

Where is that bookmark file?

If you use telnet to get to a public-access gopher, your bookmark file will be lost when you quit from gopher. Public-access accounts, which you would be using, do not allow any files to be saved, including bookmark files.

If you are using gopher on the host where you have an account, your bookmark file will be saved in your account.
Looking at sunspot data

Take a look at the monthly sunspot data by selecting monthly in the ZURICH_SUNSPOT directory.

<table>
<thead>
<tr>
<th>Year</th>
<th>Jan</th>
<th>Feb</th>
<th>Mar</th>
<th>Apr</th>
<th>May</th>
<th>Jun</th>
<th>Jul</th>
<th>Aug</th>
<th>Sep</th>
<th>Oct</th>
<th>Nov</th>
<th>Dec</th>
</tr>
</thead>
<tbody>
<tr>
<td>1749</td>
<td>58.0</td>
<td>62.6</td>
<td>70.0</td>
<td>55.7</td>
<td>85.0</td>
<td>83.5</td>
<td>94.8</td>
<td>66.3</td>
<td>75.9</td>
<td>75.5</td>
<td>158.6</td>
<td>85.2</td>
</tr>
<tr>
<td>1750</td>
<td>73.3</td>
<td>75.9</td>
<td>89.2</td>
<td>88.3</td>
<td>90.0</td>
<td>100.0</td>
<td>85.4</td>
<td>103</td>
<td>91.2</td>
<td>6.7</td>
<td>63.3</td>
<td>75.4</td>
</tr>
<tr>
<td>1751</td>
<td>70.0</td>
<td>43.5</td>
<td>45.0</td>
<td>56.4</td>
<td>60.7</td>
<td>50.7</td>
<td>66.3</td>
<td>59.0</td>
<td>23.5</td>
<td>23.2</td>
<td>38.5</td>
<td>44.0</td>
</tr>
<tr>
<td>1752</td>
<td>35.0</td>
<td>50.0</td>
<td>71.0</td>
<td>59.3</td>
<td>59.7</td>
<td>39.6</td>
<td>78.4</td>
<td>29.3</td>
<td>27.1</td>
<td>46.6</td>
<td>37.4</td>
<td>40.0</td>
</tr>
</tbody>
</table>

Questions

6–1. How many years of data are available?

6–2. Describe any patterns that you see in the data.

Saving the data to your host

If you are using a gopher on your host where you have an account, you can easily save a gopher file on your host. Just highlight or display any menu item, and press s.

The file will be saved directly on your host computer.

Downloading the data directly to your computer

If you are connected through a host, you can easily download a file in one step from gopher. Just highlight or display the menu item and press D, and then select the type of file transfer that your PC or Mac uses.

The file will be transferred directly from the remote computer through your host to your machine.
If you can’t save or download

If you used telnet to get to a public-access gopher, and none of the above methods (save, download) works for you, there are at least two ways you can move a file to the computer on your desk.

First way: While you have the file displayed on your screen, you can press m to have the gopher computer mail the file to you. Next time you read your mail, you’ll find it there. Then use your mail reader program to save the file on your computer. If your mail is on a host computer, you’ll need to transfer this file to your computer (see “Modem File Transfers” in the Help section).

Second way (best for big files): Find out what server you are connected to, and what directory the file is in (use =), and jot it down. Quit your gopher connection and establish an anonymous ftp session with the gopher computer. (Most gopher computers will also allow access via anonymous ftp.) Navigate to the directory containing the file and get it. If you are running ftp on a host, you’ll need to transfer it from the host computer to your computer.

Second way (best for big files): Find out what server you are connected to, and what directory the file is in (use =), and jot it down. Quit your gopher connection and establish an anonymous ftp session with the gopher computer. (Most gopher computers will also allow access via anonymous ftp.) Navigate to the directory containing the file and get it. If you are running ftp on a host, you’ll need to transfer it from the host computer to your computer.

Analysis

One of the great things about digital data is that computers can manipulate them. A table of numbers in a book is just that. A table of numbers in a computer can become a plot, a graph, or a chart with very little effort. This is often how scientific analysis is done—by displaying data in different ways.

So getting the data to your computer (not just to the host) is very important.
Graphing sunspot counts

To really see the patterns in the sunspot data, you'll want to make a graph of the numbers. Try to do this with the monthly sunspot file. You will need to have a spreadsheet program with a graph or chart function, or another graphing program. Because there are so many different programs available (MS Works, MS Excel, etc.) we won't try to give detailed instructions here.

These are the general steps you should follow:

Save your modified data file. If you are using a word processor, be sure to save the file without formatting (as ASCII or text).

Put the file into your spreadsheet or graphing program. For some programs, you may be able to simply start the program and then open the file; the program will place the numbers into appropriate cells. For others, you may need to copy the file from a word processor and paste it into the spreadsheet. And for some, you may need to place commas between individual data items on each line. In any case, you should work to get the numbers into individual cells.

Use your spreadsheet to perform statistics (maximum, minimum, average) and to make a graph or chart of the data. (Some graphing programs can do this, also.)

The sunspot counts are now arranged from left to right, one year to a line. Unless you have a very sophisticated spreadsheet or graphing program, you can't graph numbers in this order; the numbers in one vertical column are graphed together. For instance, you could plot all the January numbers.
Activity 6–Gopher

A better way to handle this problem is to make a 14th column to the right of the year and the twelve monthly columns. Calculate the average sunspot count for each year and put that number in column 14. For example, in MS Works, you could put \( \text{avg(b1:m1)} \) in cell n1. Then fill down to define all the averages. Column 14 then will hold yearly average sunspot numbers.

Finally, use the graph or chart function to graph the yearly average sunspot counts. You should see a dramatic pattern!

Questions

6-3. After plotting the data, describe the pattern in the sunspot data. Which recent year had a high count? a low count? How many years passed between the last two peaks?

Elvis was pretty thrilled with this sunspot data. This would help explain a lot about his ham radio operation, and he couldn’t wait to understand it all and tell all his friends about it on the air waves that evening. But the sunspot cycle only told him what “season” it was and wouldn’t really tell him anything about today’s “solar weather.” Jane thought finding the solar weather was a pretty esoteric request, but she agreed to keep looking for information and kept her doubts to herself. To her amazement, she found exactly what Elvis wanted. When she nonchalantly handed him a printout of the “High Frequency Radio Propagation Report,” he couldn’t hide his astonishment.

Get the Space Weather Forecast

After making a gopher connection, select Search all the gopher servers in the world on the main menu, and enter the key word noaa. You should get a list of at least four gopher servers that have noaa as part of their name. The one you want is NOAA Environmental Information Services Gopher. This gopher provides a great access point to almost all of the environmental data in NOAA.
Select Connections to NOAA on-line Data and Information Systems, and keep going.

Note also the Space Weather Forecast under Alerts, Forecasts and Summaries

[Connections to NOAA on-line Data and Information Systems/]
[Space Environment Laboratory/]
[Alerts, Forecasts, and Summaries/]
[USAF High Frequency Radio Propagation Report/]
[today's date HF Report (HFRP)]
(read parts II and III)

Questions

6–4. When the geomagnetic activity forecast is more than "quiet," disturbances to radio transmission are possible. What should Elvis recommend doing about the music? (Hint: look at parts II and III).
Netiquette

If you transfer a large file to your host computer and then transfer it to your own computer, remember to remove (delete) the file from the host when you are finished. If the host is a UNIX machine, use the rm command.
Activity 7: Using GeoVu to Assess Hazards
This activity requires a PC computer!

Jane's Mom and Dad were thrilled with the 25th Anniversary party. It went off without a hitch. Uncle Josh and Aunt Marcee came down from San Francisco for the week, and lots of friends and relatives from around home came too. Richard was happy to have some cousins his age there, and they went off to the basement to play on the computer. He just about missed the whole party, but that was OK with Jane. Sandy had an accident on the floor, but Jane cleaned it up right away so Mom wouldn't get upset. Jane had really done a great job making the day wonderful.

As good as the party was, the big surprise of the day came when Jane's father said that he had been asked by his company to move. They hadn't said he had to, but had offered him five places to consider: Seattle, Washington; Ocean View, Delaware; Tampa Bay, Florida; Tokyo, Japan; and Sydney, Australia.

Wow. Those were big changes! Jane immediately thought of her friends and her life in L.A. She didn't want to move. Neither did Richard. Her dad reminded them that he didn't have to move, at least not yet, but that they ought to start thinking about it.

Late that night, after the party, Jane was haunted by thoughts she had had as a young child, fears of natural hazards like lightning, earthquakes, and floods. It seemed that those fears were always associated with losing the family, and she felt a little bit afraid now. She decided to try to be more adult; that helped her get hold of herself and resolve to do a hazards study for her father. He ought to know about these cities they might move to. With that plan in mind, she fell asleep right away.

In school the next day, she looked for Mr. Goodman to help her with this project. It was a big study, now that she thought of it, and she wanted someone who really liked big, detailed projects to help her. He was delighted at the challenge, and, best of all, he knew a great tool to use.

Mr. Goodman reminded Jane that to make any sense out of information that is presented in a list or a table of numbers, you need to see the patterns by making a graph or map. NOAA's National Geophysical Data Center (NGDC) has lots of data, and they have made a special tool, called GeoVu, that allows you to graph some of the data files and even view photographs.

Jane and Mr. Goodman would get GeoVu from NGDC's computer along with the data, and run it on the school's PC running Microsoft Windows 3.1. (Versions for Macintosh and UNIX may be available in the future.) They began to search the Internet for information on hazards all over the world.
Getting the GeoVu software for a PC

Login to your Internet account and run gopher. Select the menu item that allows you to Search all gopher servers in the world. Enter the keyword NOAA. You'll quickly have a list of all of the gophers that have the word NOAA in their title.

If your gopher doesn't have this option, telnet to the University of Minnesota (see Activity 6).

Select the NGDC gopher and navigate down through the menus.

Check out the README file on this menu. It will give you some basic information about the GeoVu software. You don't need to understand it all right now. When you have finished, you should be back at the same menu.

Next, go down to the PC menu. You'll find gvinstal.exe there. When you select it, gopher will automatically send it to your computer.

Before you leave, take a peek at another read file: readme.txt. This will give you an idea of what you'll be doing to install GeoVu; you don't need to remember it all now.

Note that if you had to telnet to a computer to use gopher, you'll now get a message saying you “can't save.” You'll need to either download using gopher or get the file by using ftp. See Activity 6 for details.

Go back up one menu. Then go to the Sampler menu. There you should see a file called sampler.exe. Check the readme.txt file here also. Have the gopher send them to your computer (or ftp the files).

Quit from the NGDC gopher. You should be back at the prompt from your Internet computer.
Internet Activities Using Scientific Data

Activity 7–GeoVu

If you are using a host to run gopher, you'll need to transfer both of the files to your PC. These are big files and they take up lots of space on the host computer. If your communications program has zmodem, use it.

When you have finished, remove the two files from the dial-up Internet computer and then logout.

For help on transferring files via modem, look at “Modem file transfers” in the Help section.

>sz gvinstal.exe
>sz sampler.exe
>rm gvinstal.exe
>rm sampler.exe
logout

File size is significant if you are using a dial-up connection. For example, gvinstal.exe is just under 2 Mb, and sampler.exe is just under 4Mb. Using a modem running at 14,400 baud, the file transfers require almost an hour! This may be about the largest file you'll want to handle using a dial-up connection. The ftp transfer from the NGDC computer to another Internet computer will probably be much faster; how much faster depends on the speed of your connection and the traffic on the Net.

Installing GeoVu on a PC

In MS-DOS, go to the root directory of your hard disk. Then make two directories:

cd \\
>md geovu
>md gvdata

cd directory_with_downloaded_files
>move gvinstal.exe c:\geovu
>move sampler.exe c:\gvdata

Now change to the c:\geovu directory. The gvinstal.exe file is called a “self-extracting archive” file. When you run it, it will “explode” into lots of files and directories that make up the GeoVu program.

Now change to the c:\gvdata directory and explode the sample data file:

>cd\
>cd geovu
>gvinstal -d

>cd\n>cd gvdata
>sampler -d
Setting up GeoVu in Windows

Now start Microsoft Windows, and open the Program Manager window. Select the File ▶ Run menu item, and type this program name in the box:

```
c:\geo\v\disk\setup
```

Click on Run, and the GeoVu Setup program will run. Just follow the instructions on the screen. When it is done, you’ll have a new program group with GeoVu in it.

Exit from Windows, and change back to the `c:\gvdata` directory. Copy the menu file for the sample data to the `c:\geovu` directory.

```
cd\c:
>cd gvdata
>copy samplenmen c:\geovu
```

Change to the `c:\geovu` directory and edit the `cdmenu.lst` file:

```
>cd\c:
>cd geovu
>edit cdmenu.lst
```

Find the line with `cd_driver #L:`. Change it to `cd_driver #C:`. This tells GeoVu to look on the C: drive for the data.

Check for the following line and add it if it is not already in the file:

```
NGDC Data Sampler#samplenmen
```

This tells GeoVu what the menu item should say, and which file has the menu information.

Save the file and exit from the editor.

Guess what? GeoVu is ready to use!

Where do earthquakes happen?

One of the sample data files in GeoVu is called Significant Earthquakes. Start Windows and run GeoVu to look at it.

Use the File ▶ Set Data Source menu to select the NGDC Data Sampler. You’ll get a screen with some information about the sampler. Click on Open Data.

Select Natural Hazards, followed by NGDC Catalog of Significant Earthquakes. You’ll see a summary of what data sets and searches are open in the Status window.
In GeoVu, looking at data is called a Search. Select Search ➤ Create... You'll get a search screen. This is the heart of GeoVu; it's where you tell the program what you want to see in the data set and how it should be displayed.

Click the GO! button. You'll see a map showing the locations of all of the earthquakes in the database.

Click the ZOOMIN button. The mouse cursor will change to a crosshair (+) and you'll be able to select an area for closer inspection. Try any part of the world. Notice that the latitude and longitude scales on the sides of the picture change.

Click the ZOOMOUT button.

Click on the FACTS button to learn more about the data.

Questions

7-1. Where are the four most active seismic regions in the world?

Frequency of earthquakes

Select Documents ➤ View Histograms. A histogram will be plotted showing how many earthquakes are listed for each year in the database.

Still in the Histogram window, click on century_and_year and pull down to select magnitude_unknown. The plot shows the number of earthquakes at each Richter scale magnitude.

Close the Histogram window.
Activity 7–GeoVu

**Internet Activities Using Scientific Data**

---

### Questions

1. Why do there appear to be so many quakes in recent years?

2. What was the magnitude of the strongest earthquake in the database?

### The strongest earthquakes

Back in the Search window, click the Set Constraints button. This allows you to restrict the earthquakes that are shown on your latitude/longitude map. Click on the first List button and select magnitude unknown. Then use the two boxes to enter a minimum of 8 and a maximum of 10. Click OK. Back in the Search window, click GO! again to make GeoVu repeat the search.

---

### Questions

1. Where have most of the strongest earthquakes occurred?

2. Where in the world did that largest magnitude earthquake occur?

3. When did the largest magnitude quake happen?

4. A very large earthquake occurred in China in the 20th century. When did the quake occur (year, month, day)? How many people died?

Jane now had all the information she needed about earthquakes, but she wasn’t at all clear about what it meant. She needed to do the analysis of the data, something her science teacher always seemed to be going on about. This time, she wanted to do this analysis, because it was so important to her family and to herself. By selecting large earthquakes and plotting them, Jane was able to see where the really dangerous areas were.
Earthquake hazards were one thing, but Jane wanted to know more, especially about the East coast because she had relatives there. She saw that there were several data sets about the Chesapeake Bay area, and in particular Ocean View, Delaware, done as part of the Coastwatch Change Analysis Program (CCAP). She knew she would miss the redwoods, up north of her home. She wondered if there was more than beach in Ocean View, and decided to check on what the countryside had to offer. She spent a few more minutes getting into these files and quite a few more minutes looking at the results.

Exploring land use using GeoVu

Use the File $\rightarrow$ Open Data menu to select Chesapeake Bay (Partial) Classification, followed by Chesapeake Bay (Partial) Classification 1988/1989.

Create a Search. You'll see a different search screen this time because this is Image or Map data (the earthquake data is Point data). Select Image or Map, and click OK. You should see a detailed image of Chesapeake Bay and surroundings. If it is a black and white image, click on COLOR and select the CCAP color palette.

Notice the message at the bottom of the window: Double-click for values. Point at different places in the picture and double click. See if you can figure out what kind of land cover is at each location.

Use the ZOOMIN button. Find a map of the Chesapeake Bay area and see if you can identify where some of the squares are on the map. (Hint: the map actually covers part of southeastern Delaware.)
Activity 7–GeoVu

Internet Activities Using Scientific Data

Questions

7–9. What is the name of the bay in the lower right corner of the map?

7–10. Figure out the size of the piece of land represented by each square on your screen (that is, are the squares 100 feet by 100 feet? one mile by one mile?).

Use the Color button to select the [COLOR] [CCAP_CROPLAND/GRASSLAND] palette. Use the [FACTS] Facts button to discover the number code used for each land-use type.

Color-coding for forests

Questions

7–11. What is the land-use number for deciduous forests?

7–12. How are the deciduous forests in the Ocean View area distributed?

Use Color [COLOR] Edit Colors. The two rows of custom color boxes show the colors for code numbers 0 through 15. (Note: they are not labeled with numbers.) Click on the custom color box for deciduous forests and then click on one of the basic colors, say bright green.

Finally, click on add to custom colors. Now deciduous colors will appear as bright green on the map. If you want to see only the deciduous forests, in bright green, repeat the procedures for the other 15 custom colors, changing them to black.

Click on OK and OK again to apply your new palette to the map.
Cleaning up

If you're done with a search and want to do another, you should use Search ▶ Delete to remove the search, and close the Search window. Also, you should use the File ▶ Close Data menu to close data files. Cleaning up will release your computer's memory so that GeoVu can use it for other data.

Use GeoVu to look at pictures, explore

The sample data includes a few pictures related to natural hazards. Take a look at them. Spend some time using GeoVu to explore the other sample data.

Questions

7-13. What is the South African climate like?

7-14. What conclusions could Jane draw from the data she saw? Are there trees around Ocean View? And knowing what the earthquake data showed, do you see a clear preference in the choices her father had presented?
When you are using a public-domain program that is still being developed (like GeoVu) you can help the developer by reporting bugs (problems) and ideas that you have. You'll often find an e-mail address in the program's information screens.
Activity 8: Using Mosaic to Check the Winds

If you cannot run Mosaic because of hardware restrictions or insufficient connection to the Internet, read through this chapter, and then check out Lynx (Activity 9).

Jane had presented her findings to her father. He was quiet a long time, looking over the data she had given him and thinking about his concerned, bright daughter. He was deeply moved by her thoughtful considerations, troubled by her obvious concerns, and impressed by her ability to do such excellent research. When he asked her what her conclusions were, she was quick to list the pros and cons of each city. Her dad thanked her for the information and promised to talk about it with her mother.

Within a week, everything had changed. Her dad’s company was not going to move him anywhere, but her parents were still thinking about making a big change in lifestyle. Jane couldn’t understand it, but this move sounded better. They might just move a few miles away or a few hours away. She could still see her friends, at least sometimes.

But the surprises weren’t over. Jane’s parents seemed awfully restless, if that’s what you could call it. First they were thinking of Tokyo, and now a trip East to see family. They all hadn’t flown across the country in about 15 years, and now they were going to in a matter of days.

Richard had already started whining about the trip and how long it would take to get there. Printed on the the tickets were the departure and landing time, so he knew how long the trip should take. But his father reminded him that if they had a good tail wind, the flight could be shorter. Richard was intrigued by that. He asked Jane to find out about the winds. Oh sure, she thought, and put it out of her mind. She had packed the night before, because there wouldn’t be much time after school before they left. She wished she knew what to do. Then she realized she could get weather information on the Internet during second period. And while she was at it, she might just check the winds for Richard.

Mrs. Fine said that Jane was about to take a trip in real style—yes, of course, thought Jane—but the trip Mrs. Fine referred to was the World Wide Web (www). She explained that it is a hyperlinked system on the Internet that can be accessed by the Mosaic program and by other www tools. The initials www often appear in names of addresses, indicating that they are part of this system. Mosaic was developed at the National Center for Supercomputing Applications (NCSA) at the University of Illinois at Urbana-Champaign. Tools for the www require that your computer be on the Internet. Jane wondered if this was going to be another mind-blowing experience!
Hyperlinked documents have "hot spots" that are either words or pictures. When you click on a hot spot, other information or programs are called and you will see a new set of information. These are basically links to other documents.

By convention, if there are links in text, the text will be color, bold, or underlined to indicate that there are links available. Pictures are sometimes linked, so click on any of them and see what happens.

Mosaic is just one of the "tools" that you can use to explore the www. Others include lynx (see Activity 9) and Netscape (see "Getting Internet tools" in the Help section).

Using Mosaic

In the example that follows, we use Mosaic. There are other graphical www tools that behave much like Mosaic.

Login to your direct or SLIP-connected computer and run Mosaic. Poke around a little. Your Mosaic is probably set up to start with a "home page." It will be displayed shortly after you start the program. Try clicking on some of the hot words. Try using the Go Back button to get back. Try using the Hot List or Starting Points menu to go someplace interesting. If this is your first time with Mosaic, you'll probably want to explore for a while!

Looking at the weather

Use the File ▶ Open URL menu and type in the address of Purdue University's WXW Weather Server. There are many other weather servers on the www; this is one of the best. You may want to explore for a while. Come back to the WXW Home Page when you are done.

Mosaic
<click> on colored or underlined text

[Go Back]

[Hot List] or [Starting Points]
Go to the Surface Data page. Click on the Current Surface Map. Mosaic will automatically start a picture viewing program to allow you to look at the map. This is actual, current data! See if you can pick out Los Angeles on the west coast and Norfolk on the east coast. The map is cluttered, so you’ll need to look carefully.

Close the viewer window and click on the Southwestern US Data Plot. You should be able to pick out L.A. Click on the Mid Atlantic Data Plot. You can see Norfolk, at the mouth of Chesapeake Bay. (If your computer has lots of memory, you can leave these windows open.)

So what do the funny flag-like symbols and the numbers mean? It’s easy to learn how to read surface weather maps on www! On the Surface Data page you’ll see a button labelled Details, near the words Surface Map. Clicking on this will take you to an information page that tells all about the symbols and numbers used on weather maps. Study the information and then take another look at the symbols at L.A. and at Norfolk.

Questions

8-1. What are the temperatures in Los Angeles and Norfolk today?  

8-2. What is the wind direction and speed in each city?  

8-3. What is the sky cover in each city?  

8-4. What is the barometric pressure in millibars in each city? (Hint: on surface maps “987” means 998.7 millibars; “183” means 1018.3 millibars.)
Navigating

You’ll probably find that you get lost a lot using Mosaic. That’s half the fun! But it’s also nice to be able to get back quickly to an interesting place. Use the Navigate Add to Hotlist menu item to save the address of good spots.

Later, you can get back using the Hot List. Just select the Hot List and select the www destination that you saved.

Going to 30,000 feet

Now let’s look at the Upper Air! In the WXW Home Page, select Upper Air Data. (You may need to use the Navigate or Hot List menu to get back to the home page.) Click on one of the Details buttons and take a look at the information on Upper Air measurements. (Don’t skip this step...there’s some really important information here for reading these maps.)

Questions

8–5. How are the Upper Air data obtained?
8–6. How often are measurements made?
8–7. What is the approximate barometric pressure at 30,000 feet?
8–8. How are the weather symbols used on the Upper Air maps? (Although the symbols used are identical, there are differences in how they are used on Surface Maps and on Upper Air Maps.)

You are now ready to look at the maps for 30,000 feet. Go back to the Upper Air Data screen and click on 300 mb Map. You’ll see a weather map that looks a lot like the surface map, only there are fewer data points (can you guess why?).
Questions

8–9. Draw an imaginary line between Los Angeles and Norfolk on the map. What wind directions and speeds do you find for stations on or near the flight path?

8–10. What is the prevailing (typical) direction at 30,000 feet? Will the wind help or hinder an aircraft flying from Los Angeles to Norfolk?

8–11. What will be the temperature of the air outside the aircraft at 30,000 feet?

Go back to the Upper Air Data page and scroll down to the Contour area. Click on the Details button and read the brief information about the 300 mb wind speed contour map. Then look at the actual map. It's pretty colorful...can you tell what it means?

Questions

8–12. What time was the 300 mb wind-speed contour data taken?

8–13. On the 300 mb map, how does the speed in knots vary over the path from L.A. to Norfolk?

8–14. What is the fastest wind speed (in knots) that will be encountered on the flight? What is the fastest wind speed in miles per hour?

8–15. What important information not shown on this picture was on the other 300 mb map?
Netiquette

The "in-line images" in Mosaic require a lot of communications capacity to send over the Net. That's why Mosaic often takes a long time to load a new page. You can use less of the Net's resources by turning off the in-line images using the Options menu. If you are loading a page you've seen before and don't need the pictures, this will save you time.
The semester was finishing up for Jane. She was just a little bit sorry, because she had really liked her teachers and her classes. Still, finals and term papers had yet to be done, and she wished those were over. She had to do a term paper about the Internet, but by this time she was pretty knowledgeable about how to use it. She was ready to research more about its history and capabilities because at least now she understood everything she read. She could work on that project at home.

What worried Jane more was her science project, involving the study of "greenhouse gases" and how they affect global warming. That was taking a lot more time than she had planned. Although much of the information she needed she had found with Mosaic, she couldn't get enough time in the school's computer lab. She complained to Mr. Goodman about this as she waited for another student to finally get off one of the computers.

There is another way to get information from the World Wide Web, using a dial-up connection to a host computer, explained Mr. Goodman. Jane would be able to use her computer at home to do this work. That would be a real savings! She'd only have to compete with Richard for the computer; since he was mostly playing computer games, her parents would make sure he gave her precedence.

The program is called Lynx, and it is text based, Mr. Goodman cautioned, so you can't see any pictures on your screen. But for quickly browsing through text data on www, Lynx is a powerful tool. Jane could optimize her time on the school's computers by knowing exactly what she needed to look at, and she could download files for plotting and viewing at school later. That would be her plan for the coming weekend.
Activity 9—Lynx

Running lynx

To see if you have lynx on your host computer, type lynx at the main prompt. If you get a response, press g (for go) and enter http://www.esdim.noaa.gov. Then skip down to “Moving Around in Lynx,” below. If you don’t have lynx, read the next section.

If you don’t have lynx

If you don’t have lynx, ask your system administrator to install it. In the meantime, you can still use a public lynx provided by NOAA.

Login to your host computer.

`telnet to gopher.esdim.noaa.gov. Login as gopher.`

Select the World Wide Web item on the main menu.

Read the description in About this link.

On the same menu, select NOAA Environmental Information Services Home Page. You’ll see a screen warning that you’ll be making another telnet connection to gopher.esdim.noaa.gov, and that you should login as lynx. Do it now, and you’ll see the home page.

Moving around in lynx

Notice the bottom three lines of the page. There you will find all the help you need to successfully use lynx. You’ll mostly use the arrow keys, `enter`, the `spacebar`, and b. Try them right away to see how they work.

* You may be wondering why we didn’t simply have you telnet directly to gopher.esdim.noaa.gov. Well, you can! We just wanted to remind you that the first gopher connection is a great jumping off point for lots of other NOAA resources.
Explore the page a bit, and try linking to other pages and coming back to the home page. If you get completely lost, that’s okay; just hit <delete> and you’ll see a history of where you’ve been. Select the place you want to return to. When you are ready to continue, go back to the home page.

<delete> to see a history of where you’ve been

**Download pictures**

When you try to select a picture, lynx will give you an opportunity to download it. Don’t do it unless you are running lynx on a computer where you have an account! If you are using a telnet connection to a remote machine where you do not have an account, the picture would be transferred there and you might not be able to save it. Even if it worked, the picture file would be difficult to find and transfer to your computer.

### Looking for data

Press g (for go), and enter the URL (Uniform Resource Locator) address of any location in the Web that you desire. We want to go to the Climate Monitoring and Diagnostics Laboratory and get some greenhouse gases data.

Enter http://www.cmdl.noaa.gov and you’ll see the CMDL home page. As usual, explore if you want.

Scroll down the CMDL home page and select Processed Data. As the screen notes, you’ll be connected (via anonymous ftp) to ftp.cmdl.noaa.gov.

This computer has information about climatic changes, and you can browse the data using lynx.

Select Methane and Carbon Dioxide; lynx is actually performing ftp operations for you now. You’ll be switched to the directory with data on these greenhouse gases.

Select co2, and then flask. Look at the README file to get information about how flask measurements are taken for carbon dioxide. You’ll also find a list of all of the stations where these measurements have been made. Note the abbreviations for some that interest you. As an example, we’ll be using the spo (South Pole Scott-Amundson Station) data.
Activity 9-Lynx

Select month, and spomm. You'll see monthly averages for atmospheric CO₂ levels at the South Pole going back to 1975.

Questions

9-1. What trends do you observe in the monthly CO₂ concentration at the South Pole?

Getting the data onto your computer

With the spomm files on your screen, move the file to your host computer. (Like Mosaic, lynx allows you to save a file on the disk of the computer that is running lynx.)

Press p, and select save to a local file. The file will be saved on your host computer. Then download if you need to.

If you are running lynx via telnet to another computer, you can't save. But you can still get the file! Press p, and select mail. Enter your own e-mail address and the file will appear in your mailbox next time you read your e-mail. Save it in a file on your host computer and download as usual.

When you are done exploring, quit from lynx.

Another method for getting a file is to quit from lynx and use an ordinary ftp file transfer. Before you leave lynx, press = to find the name of the computer and the directory to go to. In this case, the data is on ftp.cmdl.noaa.gov, in the directory co2ch4/co2/flask/month. The file name is spomm.

Analysis of the data

When you have the file on your computer, clean it up and load into a spreadsheet or graphing program. Be sure to take the time to get the data to your computer, make a chart, and interpret the data. Then do some more research on the changes in concentrations of greenhouse gases.

edit with word processor and clean up file
save in ASCII text
load into a spreadsheet or graphing program
Questions

9-2. If the CO₂ concentration at the South Pole continues to increase at the same rate, how many years will it take to double?

9-3. Use lynx to view the monthly concentrations of methane (CH₄) at the South Pole. At the same rate of increase, how many years will it take to double the CH₄ concentration?

Jane was pleased to get so much information for her project. She had finished up her term paper, and in the process added to her knowledge of the Internet (look at the next chapter for the results!). She was also well on her way to finishing the science project. Sandy had not helped in the process—she had chewed up the final copy of the paper. In the "old days," that would have been a catastrophe, but Jane had only to print out another copy. She decided to back up her reports on a floppy so that if something happened to her hard drive, there wouldn't be a disaster as bad as in the old days.

Using lynx as a general-purpose access tool

For general net-browsing of text information, lynx is an excellent tool. By pressing G (for Go) you can enter any Uniform Resource Locator (URL). For example, consider the URL:

http://web.ngdc.noaa.gov/dmsp/ols-app-city.html

http:// is the service type
web.ngdc.noaa.gov is the host (computer)
/dmsp/ols-app-city.html is the path and file name

You can specify several service types:

http:// hypertext
ftp:// or file:// anonymous ftp
gopher:// gopher
telnet:// telnet

Once you have typed in the URL, lynx will display the appropriate page, directory, or menu, depending on the service. Navigation is easy and standardized: use the arrow keys and <spacebar> to move around. This is a particularly good way to explore an anonymous ftp site.

If you have a lynx client on your host computer, you may save any file that you encounter (including pictures and programs) on the host. If you are using dial-up, you may also download using kermit, zmodem, and other protocols.

You can also use the URL concept with other www tools such as Mosaic and Netscape.
Whenever you are downloading from the Net, you open up your system to viruses. Take precautions to protect your system. And when you've been infected and need to take the time to fix your system, consider how destructive and time-wasting this criminal act is.
The Internet

History of the Internet

In the early 1970's, the U.S Defense Department implemented an experimental network of military computers called ARPAnet (Advanced Research Projects Agency network). It turned out to be the forerunner of today's Internet. The ARPAnet design assumed that the physical connections (mostly telephone lines) were unreliable; any computer or link could fail or be disabled at any time (say, by a bomb attack). Designers achieved reliability by connecting computers using many different paths ("redundancy") and by using "packets" to send data. This meant that every message sent over the network was broken up into pieces (packets) at the sending computer and sent individually to the receiving computer, where the packets were reassembled in the correct order. Each packet could in fact take a different path from the others, depending on the status of the network. Today, the Internet uses the same method to transmit data.

By the 1980's, research organizations (including universities, corporations, and non-military government research agencies) were using local area networks and wanted to connect them to the ARPAnet. Some of these organizations, like the National Science Foundation, also built their own nation-wide networks. NSF tried to use the ARPAnet as a basis for its communications; this attempt failed because of administrative and security problems that occurred when military and non-military uses of the network began to mix.

In the late 1980's, NSF responded by building its own network based on the packet-switching technology. Supercomputing centers were used as hubs, and other organizations connected to the hubs. NSF designers connected the hubs with high-speed telephone lines, fiber optics, and microwave links. Suddenly, universities, corporations, and government agencies were connected to each other with standardized, high-speed data links. Use of the network grew exponentially, and users began calling the whole thing "The Internet." Small businesses, public schools, and individuals joined the Net rapidly, and the growth continues today. In late 1994, over 50 million people use the Net!

The computers and "wiring" that make up the Internet continue to improve and expand. The number of computers on the Net is hard to estimate, but are believed to number in excess of 50,000. Ancient IBM PCs and Cray Supercomputers communicate with each other, using telephone lines, coaxial TV
cable, fiber optic cable, Earth based microwave links, communications satellites, and undersea cables.

**Users of the Internet**

All kinds of people use the Internet and they are doing all kinds of things! To illustrate, here are just a few examples of "who's doing what:"

- a seventh grader writes a letter to the Vice President of the U.S.
- three artists in three countries make a collaborative drawing
- an oceanographer studies the effect of ocean waves on fish reproduction
- a 17 year old musician shares her latest keyboard composition with an Austrian composer
- 25 people from 10 countries discuss the war in Eastern Europe
- a high school physics study group uses Hubble Space Telescope images to study cosmic collisions
- a rock band advertises for gigs
- a ten-year-old publishes an on-line magazine about fashion

All of these and many other things (some of them very strange!) are happening on the Internet. You have probably read about some of the more unusual uses of the Net in newspapers or magazines. If you stop and think about it, you'll see that all of these activities have one thing in common: people are exchanging information.

**The rules for using the Internet**

The Internet is not a corporation or a government organization...there is no CEO or king. Instead, the Net is controlled by its users, and by organizations that provide access. An organization of volunteers called the Internet Society helps to maintain technical standards for worldwide computer communication. There are technical "protocols" that all computers on the Net must use; all data packets are constructed and handled using the same "language" on the Net.

Sometimes the organization providing your access will place restrictions on your use of the Net. You may be able to connect for a limited amount of time; you may not be allowed to play games on the Net; and so on.

Because the NSF built and owns large pieces of the Net, the NSF currently does have some say in how its part of the Net may be used. These requirements are detailed in the "NSFNET Acceptable Use Policy."

Under the Acceptable Use Policy, some activities are not allowed on the Net. Service providers can revoke a user's Net privileges for the following:

- harassment of other users: e.g. sending repeated, unwanted e-mail messages to someone
use of obscene language and material: e.g. transferring, storing, and making such material available on the Net

theft or damage to data or equipment: e.g. physically damaging network wires, cracking security systems, reading or changing secured data

Of course, some of the above activities might result in legal prosecution. There are also some informal agreements that are followed by almost all Internet users; these are discouraged by most service providers:

- anonymous use of the Net: users are responsible for their activities
- excessive playing of games: research and education get top priority for use of Net resources (computing time, channel capacity, computer memory and mass storage)
- use that is not in support of research and education: however, in late 1994, many service providers are beginning to allow (and even encourage) commercial use of the Internet

The Net is mostly self-policing by responsible users and gentle (or not-so-gentle) reminders to errant or rude users. Many organizations ask users to sign Internet use agreements that list acceptable uses and limitations for users. As schools and school districts gain access, staff, students, and their parents or guardians are usually asked to sign agreements before using the Net.

**Scientific information exchange**

Scientists exchange a lot of different kinds of information. Here’s a brief list of some of the ways that the Net is used in support of science:

- memos and letters
- databases and spreadsheets
- charts
- photographs
- movies
- maps
- computer programs
- computer printouts

(data type: text files)

(text files or binary data files)

(image files)

(image files)

(movie files)

(image files)

(text files or program files)

(text files or Postscript files)

Computers save and exchange information using “files,” which are simply collections of “characters” (like s, ., 7, Q, +, ?). To use any of the above file types, you must run a computer program. Different kinds of files require different programs:

- You can read a letter with an e-mail reader program.
- You can look at a map with an image viewer program.
- You can watch a movie by using a movie viewer program.
- And of course, you would use a spreadsheet program to work with data in a spreadsheet format.

It would not be possible in this paper to list all of the possible types of computer files that you might encounter on the Internet, and the computer
programs that you need to use them. There are just too many, and (like most everything on the Net) things keep changing. And to complicate matters even more, some files are really combinations of the types listed above, and some are compressed to save space.

New Internet access tools are reducing the need to deal with these "techie details," but this simplification is happening rather slowly. Still, it is possible to get into real science right now.

**Computer equipment and software requirements**

The computer equipment and software doesn't have to be very expensive or hard to get. An IBM-compatible PC or an Apple Macintosh with some simple programs and a modem and telephone line is all you need.

In addition to the programs already on your computer, you can obtain other programs ("freeware" and "shareware") from the Internet. These programs may be obtained at no cost, or for a small ($10 - $75) fee. That's good news... the other good news is that you can often run and use Internet access programs on the computer that you are connected to (instead of your own). You don't need to worry about getting and installing these programs; just connect and run.

Here's a list of some standard Internet-access UNIX programs that you can use on most of the computers that are on the Internet:

- **pine, elm, or mail** (for electronic mail)
- **telnet** (to connect to other computers)
- **ftp** (to get files from other computers)
- **archie** (to search for files on other computers)
- **gopher** (to browse through other computers and get files)
- **lynx** (to navigate the World Wide Web using text)
- **Mosaic or Netscape** (to navigate the World Wide Web using graphics)

All of the above programs work with a computer that is connected to the Internet using a dial-up connection to a host computer.

**Connection to the Internet**

If you work for a company or attend a school that has an Internet connection, you may be able to get access for free (although someone is paying for it). You may be able to use a computer that has a "direct connection" to the Net, or you may even have one on your desk. In addition, many companies, universities and school districts allow you to use a telephone "dial-up connection" to a computer that is on the Internet.
Internet Activities Using Scientific Data

If you are not so lucky, you can still get a free or low-cost dial-up connection in most urban areas of the U.S. from a private service provider for about $15 per month, plus hourly access charges. Some people can connect for free to an Internet computer through local universities.*

The future of the Internet

The Internet is a vast, complex, and changing place. It's impossible to predict exactly what the Internet will be like in a year, let alone a decade. But here are some things that seem to be happening (in late 1994) and some trends:

- increased commercial use and other privatization
- lower cost for access (although this may change if providers start passing the true cost on to users.)
- continued exponential growth of users and data exchange
- increased funding and involvement by the U.S. government
- easier-to-use access tools (especially graphical user interfaces)
- integration of Net data with other media (video, sound, telephone)
- rapid introduction into K-12 schools

I believe that everyone will learn to use the Internet in school in the next decade and that someday it will be used like telephones are today.

---

* A friend whose family just moved to Colorado has been able to get a free connection called "nyx" at the University of Denver (DU). It provides all of the access tools described above. He says it is hard to get your modem connected during the peak evening hours when everyone is reading their e-mail.
HELP
for the Local Technician
Getting Started

Introduction and References

This section contains technical information that you might need to set up and use your Internet connection. Use the information here, ask people in your organization for help, and use Internet e-mail to ask questions. Most folks on the Net like to share information!

There are many books available to help new Internet users. The list below shows some of our favorites. You can get a current list of about 100 books, complete with short reviews at http://plaza.xor.com/softpro.


An Internet account

You will want to read the section “Three kinds of connections” to understand your choices, but in each case you will need an Internet account. This can be an account on someone else's Internet computer, or it can be an account set up on your personal machine.

If you are working at a school or business that is already on the Internet, you may only need to get a computer account from the system administrator. You will be assigned a login name, a password that you can change, and usually a home directory where you can save files.

If you are using a dial-up connection, you may need to find an Internet provider in your area. You then pay for monthly service from that provider. Finding this is not as easy as looking in the Yellow Pages—yet—but universities in your area might be of some help. Just to get you started, here are some companies in the business of providing Internet access.

- Colorado Supernet (info@csn.org)
  Colorado School of Mines
  1500 Illinois Street, Golden, CO 80401
  (800) 748-0800
- UUNET (info@uunet.uu.net)
  3110 Fairview Park Dr., Suite 570, Falls Church, VA 22042
- Institute for Global Communications
  (support@igc.apc.org)
  18 deBoo M., San Francisco, CA 94107
  (415) 442-0220, fax: (415) 546-1794
- Internet Express (gopher://csca.com)
  (800) 592-1240
- America On-Line (info@ail.com)
- Compuserve (http://www.compuserve.com)
- JVNCnet (market@jvnc.net) SLIP only
- Global Enterprise Services
  3 Independence Way, Princeton, NJ 08540
- NetCom On-Line Communication Services
  (info@netcom.com)
  4000 Moorpark Avenue, Suite 209, San Jose, CA 95117 (408) 554-8649
- Performance Systems Int'l. (info@psi.com)
  11800 Sunrise Valley Dr., Suite 110, Reston, VA 22019 (703) 620-6651
**Equipment and software requirements**

Most Internet access that involves only text display requires only a basic system. For Mosaic (and GeoVu), you need a much bigger system. Two configurations are defined below for PCs and Macs:

<table>
<thead>
<tr>
<th>PC-type equipment and programs</th>
<th>MOSAIC (and GeoVu)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Non-MOSAIC</strong></td>
<td></td>
</tr>
<tr>
<td>IBM compatible 8086</td>
<td>IBM compatible 80386 or better computer</td>
</tr>
<tr>
<td>8 MHz or faster clock</td>
<td>20 MHz or faster clock</td>
</tr>
<tr>
<td>640 kb or more of RAM</td>
<td>4 Mb or more of RAM</td>
</tr>
<tr>
<td>2 Mb or more of free hard-disk space</td>
<td>10 Mb or more of free hard disk space</td>
</tr>
<tr>
<td>black-and-white monitor</td>
<td>VGA color monitor (640x480 pixels, 16 colors)</td>
</tr>
<tr>
<td></td>
<td>mouse</td>
</tr>
<tr>
<td></td>
<td>9600 baud modem or faster</td>
</tr>
<tr>
<td></td>
<td>MS-DOS 3.0</td>
</tr>
<tr>
<td></td>
<td>MS-DOS 6.0</td>
</tr>
<tr>
<td></td>
<td>MS Windows 3.1 or higher</td>
</tr>
<tr>
<td></td>
<td>Internet tools</td>
</tr>
<tr>
<td>A communications program</td>
<td>A word-processor program</td>
</tr>
<tr>
<td>A word-processor program</td>
<td>A spreadsheet or graphing program</td>
</tr>
<tr>
<td>A spreadsheet or graphing program</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Macintosh equipment and programs</th>
<th>MOSAIC</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Non-MOSAIC</strong></td>
<td></td>
</tr>
<tr>
<td>Macintosh MacPlus</td>
<td></td>
</tr>
<tr>
<td>1 Mb RAM with Sys 6, no MultiFinder</td>
<td>System 7.0 or higher operating system</td>
</tr>
<tr>
<td>2.5 Mb RAM with Sys 6, MultiFinder</td>
<td>4 Mb or more of RAM</td>
</tr>
<tr>
<td>4 Mb RAM with Sys 7</td>
<td>10 Mb or more of free hard-disk space</td>
</tr>
<tr>
<td>2 Mb or more of free hard-disk space</td>
<td>color monitor</td>
</tr>
<tr>
<td>black-and-white monitor</td>
<td>mouse</td>
</tr>
<tr>
<td>2400 baud or faster modem</td>
<td>9600 baud or faster modem</td>
</tr>
<tr>
<td>A communications program</td>
<td>Internet tools</td>
</tr>
<tr>
<td>A word-processor program</td>
<td>A word-processor program</td>
</tr>
<tr>
<td>A spreadsheet program</td>
<td>A spreadsheet program</td>
</tr>
</tbody>
</table>
Three Kinds of Connections

The key concept in "being on the Internet" is how you are connected: being part of the Internet is having a TCP/IP connection and an Internet Protocol (IP) address. If your computer does not have both, it is not on the Internet. You can still do work on the Internet by connecting to a computer that is on the Internet.

There are three scenarios pertaining to connecting to the Internet. These are slightly different from the functional connections described in the Introduction; the diagrams here show the technical connections. Note the differences.

Interactive account dial-up connection

You can establish a dial-up connection from any location that has an ordinary telephone line that can be connected using a standard modular telephone plug. Just plug your modem into the telephone line and you are ready to go. (See "Sharing telephone lines".)

With a dial-up connection, your computer is not actually on the Internet. Rather, you use your keyboard to control the host computer (the one to which you have connected) on the Internet. It’s like having a really long wire connecting your keyboard and monitor to the remote computer. There’s a catch, however: You can only see text (characters) on your monitor screen; you can’t display pictures from the Internet directly on your screen.

In this common situation, you must often use a special program to transfer a file from the host computer to your computer. For example, let’s say that you want to look at a picture file that is stored on a computer at NOAA. With a dial-up connection, here’s what you would do:

1. Connect your computer to the host computer using your communications program.
2. Run ftp on your host computer. This program allows you to transfer the picture file from the NOAA computer to your host computer.
3. Transfer the picture file to your computer using the file transfer function in your communications program.
4. View the picture using an image viewer on your computer.

You will use a similar sequence to obtain scientific data files for viewing or analysis. The file transfer to your own computer is necessary any time you need to use one of your own programs to work with the file to display pictures, graphics, or movies. Again, the reason you need to do this is that the host computer probably can’t display a picture on your screen. So you must send the whole file to your computer, which has the required hardware and program to display it for you.

* The exception to this is the SLIP dial-up connection. See "SLIP connection" on page 85.
The drawbacks to this kind of connection are that the transactions are slowed by your modem connection, and you cannot run Mosaic. There are some advantages, though. You don’t have to take care of installing and maintaining the Internet tools, you can get to your host computer anywhere there’s a regular phone line, and you can have account files (and e-mail) on a central host computer.

* With a dial-up connection, you have an account on the host computer. You do not have an IP address (although you may have an e-mail address on the host computer). You cannot run Mosaic in this configuration.

Direct connection

Direct connections of PCs, Macs, and workstations to the Internet are usually available only at companies, schools, and other organizations that have a local area network (LAN) connecting the computers in their building(s) plus a high-speed connection to the Internet. In this situation, many of the computers in the organization are directly connected to the Net, and you usually don’t need to do anything to set up your computer for use on the Internet. A direct connection requires that the essential Internet tools are installed on your computer.

Let’s outline the picture-file example with a direct connection:

1. First run ftp and transfer the picture file from the NOAA computer to your computer (they are both on the Net)
2. Then use your image viewer to look at the picture.

This looks (and is) much simpler and faster than dial-up, but not everyone has this kind of access.

And to go a step further, to look at a picture from NOAA that is on the www:

1. Run Mosaic or another www tool and view the picture.

Using a computer with a direct connection to the Internet has some obvious advantages: things usually move faster, you don’t have to perform modem file transfers, and (best of all) you can use Mosaic.

* Using this connection, “your computer” will have an IP address and will run Internet tools. If “your computer” is a Mac or PC, you will want to get and run the Internet tools that work for your computer type. A list of suggested tools is included in “Direct Connection Internet Software for the PC (or Macintosh). You can run Mosaic in this configuration.
SLIP connection

If you are using a telephone line and modem to connect to the Internet, you can actually simulate a direct connection if your Internet provider offers Serial Line Internet Protocol (SLIP).*

A SLIP connection sends TCP/IP data packets over the telephone line to your computer. Your computer has an IP address and is truly on the Internet; the “SLIP server” (the one you are connected to via telephone line) does nothing except pass packets to and from your computer.

You can buy a SLIP account from an Internet provider. (It usually costs more than a regular dial-up connection.) In addition to purchasing your account and getting your Internet domain name registered, you’ll need to set up your computer to exchange data packets with your modem. There are several programs that can do this for you, and help is available on the Internet (see the section “Getting Internet Tools”).

The biggest drawback to a SLIP connection running Mosaic may be speed. It’s not uncommon to transfer 100,000 bytes of data just to switch from one page to another. A 14,400 baud modem will transfer between 500 and 2000 bytes per second (depending on network conditions) on a SLIP line. So 100,000 bytes could take from 50 to 200 seconds. And Internet providers may be underequipped to handle all their clients’ data requests instantaneously.

Mosaic does allow you to turn off the display of “in-line images” (the pictures that appear on many www pages). If you do this, the pages won’t look as nice, but you’ll be able to load pages much more quickly. When you need to see a picture, just turn the in-line images back on and use the reload menu item to get the page again, this time with the pictures. The advantages are the same as for a direct connection.

* Using a SLIP dial-up connection, you have the functionality of a direct connection. You use a TCP/IP connection and have an IP address. This configuration, once you dial the modem and connect, looks exactly like the direct connect. You can run Mosaic but must accept the limitations of your modem speed.

* A similar connection is called Point-to-Point Protocol (PPP). Most of the statements made about SLIP apply to this connection as well.
Requesting a SLIP account

Before you get started, contact an Internet provider in your local telephone calling area and request a SLIP dial-up account. (All the Internet providers mentioned in “Getting Started” handle SLIP connections.)

The service provider will give you the following information, which is required to set up your SLIP connection:

- SLIP telephone number
- maximum baud rate
- SLIP login name
- password
- domain suffix
- your IP address
- nameserver IP address
- default gateway IP address
- time server IP address
Modems and Telephones

Modem cables

IBM-style modem cables usually have 25-pin connectors on each end, (one male and one female). The male end connects to your modem, and the female end connects to one of the serial ports (there may be two or more) on the back of your computer. If you have an unusual cable or computer, you may need to get a gender changer to get everything to fit together.

Macintosh cables have the same male modem connector on one end and a small round Macintosh serial port connector on the other end. You should plug the small connector into the port with the "telephone" symbol on the back of your Mac.

(Modem cables don't usually come with the modem!)

Modem lights

Most modems have eight lights. Here is what they mean to you, the dial-up Internet user:

- **MR:** Modem Ready.
  - The modem power is turned on and the modem is ready to go.

- **TR:** Terminal Ready.
  - Your computer's terminal (communications) program is ready to work with your modem.

- **HS:** High Speed.
  - Your modem is set to work at its highest speed.

- **OH:** Off Hook.
  - Your modem is listening or sending on the telephone line.

- **CD:** Carrier Detect.
  - Your modem has established communication with the host computer.

- **TX or SD:** Transmit.
  - Your modem is sending data to the host computer.

- **RX or RD:** Receive.
  - The host computer is sending data to your computer.

- **AA:** Automatic Answer.
  - Your computer will answer the phone if it rings. This light should not be on for normal Internet use.
Help for the Local Technician

Sharing telephone lines

At a business

Many large organizations use PBX telephone systems. Unfortunately, you can’t connect your modem to the wall sockets with these systems. If your telephone has functions like “hold,” “intercom,” and multiple line dialing, then you have a PBX system and you can’t use it with your computer. However, fax machines also require ordinary telephone lines, so you can usually connect your modem to any line that can be used by a fax. If you are not sure where an ordinary line is, ask the telephone specialist in your organization.

If you’re trying to set up a dial-up connection and you only have PBX telephone lines in your building, you can’t plug a modem into the PBX jacks. Here are some solutions to consider:

Find a suitable line. Most buildings have a few standard telephone lines (sometimes referred to as “data lines”). They are used for fax machines and for remote security systems. Ask around. Maybe there is one that is not being used.

Have a new line installed. Of course, you’ll need to consider your budget, plans for your building, etc. Installation can cost several hundred dollars, plus several hundred dollars per year for service.

Have an analog terminal adaptor (ATA) installed on one of your PBX lines. This is a box that converts the PBX digital signal to a standard analog telephone signal. These cost several hundred dollars, and they must be installed by a qualified technician. Talk to your building telephone administrator, and/or your local telephone company.

At home

At home, you’ll usually have no problem. Just plug the wire from the modem into a wall jack and then plug your phone (if you want) into the modem. Your phone will work fine when you are not using the modem. Of course, when you are using your computer on the Internet, no one else in your house can use that telephone line. Incoming callers will get a busy signal. If you use the Internet a lot and you live with other people, they may encourage you to get a separate line. If you have call waiting, you will need to turn it off for your computer session. This can be done by placing the call waiting disable code before the telephone number in your communications program’s telephone number field (for instance, *73, 555–1237)

If someone picks up another telephone extension while you are using your modem, you might lose the connection to your host computer, if the extension is off hook too long. Some modems can automatically recover; some can’t. It is good to let others know that you’re on the modem, but occasional disconnects are inevitable.
Establishing a Dial-up Connection
Using a PC with Windows

If you are using a PC computer with a dial-up connection, you'll need to set up your communications program before you can connect to the host computer. This section outlines the procedure for one very common program. The procedures for other communications programs are similar.

* If you have an account on a host computer, this is all the software you will need to use all the Internet tools (except Mosaic.)

Setting up Terminal in Microsoft Windows

If you have a PC computer with Windows, then you also have the Terminal program; it's in the Accessories program group. Because so many people have this communication program, we list some key steps here for setting it up for the Internet.

Start the Terminal program by double clicking on its icon. You'll get a window titled Terminal - (Untitled).

Phone Number: Enter the telephone number for the host computer. If you need to dial 9 to get an outside line, put 9 followed by two commas right in front of the number.

The time-out setting can be left at 30 seconds. Change this later if the host computer takes more than 30 seconds to answer and connect.

You can set the program to automatically redial until a connection is established, and you can have the computer beep when it does connect. Mark the remaining two check boxes according to your preference.

Terminal Emulation: Select the DEC VT100 (ANSI) button. Your terminal will now "pretend" to be a Digital Equipment Corp. model VT100. This is an almost universal convention used on the Internet for working with simple text screens.
Help for the Local Technician

Terminal Preferences: UNcheck the Use Function, Arrow, and Ctrl Keys for Windows box. This causes your computer to send the correct signal to the host computer when you press the arrow keys.

[Settings ► Terminal Preferences]
☐ Use Function, Arrow, Ctrl Keys for Windows
(not checked)

Leave the other settings alone.

Binary Transfers: For now, select the Kermit button. Most host computers can send files to your computer using the Kermit method.

[Settings ► Binary Transfers]
[Kermit]

Communications: Set the Baud Rate to the highest speed that your modem can handle. Set the Flow Control to Hardware.

[Settings ► Communications]
[Baud Rate] 9600
[Flow Control] Hardware

Select the Connector that you have used to connect your modem. Usually, this is the COM1 serial port.

[Connector] COM1

Leave the other settings alone.

Save: Enter Internet in the File Name field.

[File ► Save]
[File Name] Internet

Exit: The Terminal program will quit. You have created and saved a file called internet.trm that contains the required setup for using your host connection.

[File ► Exit]

Now, test your setup. Start the Terminal program and use the File ► Open menu to select the internet.trm file. Then use the Phone ► Dial menu to connect to the host computer.
Establishing a Dial-up Connection
Using a Macintosh

If you are using a Macintosh computer with a dial-up connection, you'll need to set up your communications program before you can connect to the host computer. This section outlines the procedure for one very common shareware program. The procedures for other communications programs are similar.

* If you have an account on a host computer, this is all the software you will need to use all the Internet tools (except Mosaic.)

Setting up ZTerm

If you have a Macintosh computer with ZTerm, you can use the following procedure before connecting to the host computer.

Start ZTerm by double-clicking its icon. <click><click> on ZTerm program

Use the Dial ▶ Directory menu to open a new connection in the Dial Directory window. [Dial ▶ Directory] [New] [Connection]

You will get a window that allows you to enter information for your Internet connection. [Service Name] Internet [Phone Number] 5553423 [Data Rate] 9600 [Data Bits] 8 [Parity] None [Stop Bits] 1 [Local Echo] (leave unchecked) [Flow Control] (check [Hardware Handshake])

Click OK to save the connection information. Then click the Terminal button. [OK] [Terminal]

Select the VT100 radio button and click OK. This makes your computer emulate a VT100 terminal. [VT100] (check box) [OK]

Now close the Dial ▶ Directory window and select the Settings ▶ Modem Preferences menu item. Set the Serial Port to Modem Port (be sure you plugged the modem into the telephone icon port on the computer). Then click OK to close the Modem Preferences window. [Close] Dial Directory window [Settings ▶ Modem Preferences] [Serial Port] [Modem Port] or [Printer Port] [OK]
The ZTerm connection named Internet is ready to use. Pull down the Dial menu to Internet, and ZTerm will dial and connect to the host computer.

ZTerm will automatically save the definition for the Internet connection. Just use Dial ➤ Internet each time you wish to start an Internet session.

[Dial ➤ Internet]
UNIX Editors for E-mail

There are many different editors, and each is a little different. Here are some common commands for a few of the popular editors.

Some pine composer commands

The pine composer is a full-screen editor that is built into the pine mail program. It is easy to use.

<table>
<thead>
<tr>
<th>To</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>move cursor</td>
<td>&lt;arrow keys&gt;</td>
</tr>
<tr>
<td>enter text</td>
<td>just type</td>
</tr>
<tr>
<td>delete text</td>
<td>&lt;backspace&gt; or &lt;delete&gt;</td>
</tr>
<tr>
<td>get help</td>
<td>commands at bottom of screen, or ?</td>
</tr>
<tr>
<td>save and quit</td>
<td>&lt;ctrl&gt;x</td>
</tr>
</tbody>
</table>

Some pico commands

The pico editor is a full-screen editor that is often used with the elm mail program. You may also use it for general editing of text files on the host computer:

<table>
<thead>
<tr>
<th>To</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>move cursor</td>
<td>&lt;arrow keys&gt;</td>
</tr>
<tr>
<td>enter text</td>
<td>just type</td>
</tr>
<tr>
<td>delete text</td>
<td>&lt;backspace&gt; or &lt;delete&gt;</td>
</tr>
<tr>
<td>get help</td>
<td>commands at bottom of screen, or ?</td>
</tr>
<tr>
<td>save and quit</td>
<td>&lt;ctrl&gt;x</td>
</tr>
</tbody>
</table>

Some vi commands

The vi editor is a full-screen editor with many advanced capabilities but it is difficult to learn. You will find it on most host computers that use the UNIX operating system. It can be used to edit any text file. The tricky thing about vi is remembering which mode you are using:

<table>
<thead>
<tr>
<th>To</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>enter .input mode</td>
<td>I (while in command mode)</td>
</tr>
<tr>
<td>enter command mode</td>
<td>&lt;esc&gt; (while in input mode)</td>
</tr>
<tr>
<td>move cursor</td>
<td>&lt;arrow keys&gt; (while in command mode) type (while in input mode)</td>
</tr>
<tr>
<td>enter text</td>
<td>&lt;backspace&gt; (while in input mode) x (while in command mode)</td>
</tr>
<tr>
<td>delete text</td>
<td>man vi (outside of vi)</td>
</tr>
<tr>
<td>get help</td>
<td>:wq or ZZ (while in command mode)</td>
</tr>
<tr>
<td>save and exit</td>
<td>:q! (while in command mode)</td>
</tr>
<tr>
<td>exit without saving</td>
<td></td>
</tr>
</tbody>
</table>
Changing your editor in elm

If you use elm on your host computer, you will get the “default” editor when it’s time to compose your message. One of the best editors to get started with is pico—it's easy to use and has some nice features. Unfortunately, some host computers will give you med (mail editor) or vi (visual editor); med has very limited capabilities, and vi can be hard to learn. With elm, you can select any editor that's available on the remote Internet computer instead of having to use the default. Here's how:

First, if you have asked to mail a message and find yourself in med or vi, you need to get out! If you're in vi, enter :q! If you're in med, enter a period (.) on a line all by itself. Either way, you should exit from the editor, and elm will ask you if you'd like to send your message. Instead of sending the message, enter f to tell elm to “forget it.” Then elm will return to the main screen.

Press o to enter the elm options screen.
Press e to select the editor option.
Enter pico.
Press > to save the change and return to the main elm screen.

Now try sending a mail message with m. When it is time for the editor to pop up, you should see the pico editor.

If you get an error message instead of pico, you may have mistyped pico on the options screen or pico is not available on your system. If this is the case, or if you have other problems selecting an editor, contact the system administrator for the host computer.

If you decide to learn to use vi, ask the system administrator how to get information on the version of vi that is used on your system, or get a book about UNIX that has a chapter on vi.
Getting Internet Tools for a Direct or SLIP Connection

If you are on a workstation with a direct connection to the Internet, your system administrator probably has set up the basic access programs. However, if you plan to set up a new SLIP connection (see “SLIP Connection”) on your own, you may be the system administrator.

If your computer is directly connected to the Internet (or if you have a SLIP connection using a modem) and you want your computer to act as “host,” your computer must have “client” programs that can send data on the Internet. The Internet clients that run on your PC or Mac are slightly different from the ones running on a UNIX host. Each of the common Internet functions (telnet, ftp,finger, etc.) requires a client program. Often there are several client programs available for each Internet function, and some programs will perform several functions. You will want to run this client software, especially Mosaic, if at all possible.

★ This section describes the tools that you will need and where they are for PC MS-DOS, PC Windows, Macintosh, and UNIX computers.

Where to get information on setting up SLIP

You can find the information on setting up Mosaic and SLIP connections for your system, along with Mosaic, on the World Wide Web.

If you have access to the www, use a viewer to connect to:
http://www.ncsa.uiuc.edu/SDG/Software/SDGSoftDir.html

If you have access to anonymous ftp:
open a connection to ftp.ncsa.uiuc.edu and change directories to /Web/Mosaic.
select the appropriate software for your computer by changing directories to mac, windows, or unix.

Using either technique you will find the Mosaic program for your computer, along with several information files that will help you establish a SLIP connection and set up your www client.

Where to get the tools

Client programs are designed to run on a particular type of computer (e.g. Mac, PC, or UNIX), and many are available on the Internet via anonymous ftp. To get these programs you’ll need to be able to get programs via anonymous ftp (don’t forget to use the bin command before transferring files), and you’ll need the appropriate program to uncompress the files. Information on using stuffit-expander (for Macintosh files) and unzip (for PC files) can be found in Activity 5.

The most commonly used client programs are available as public-domain software or as shareware. On the next pages are Internet sources that you can use to get these programs. Once you have the programs, you must follow the instructions provided with the software.
### Client programs for Macintosh

<table>
<thead>
<tr>
<th>Client</th>
<th>Description</th>
<th>ftp host</th>
<th>ftp directory</th>
<th>file name</th>
</tr>
</thead>
<tbody>
<tr>
<td>NCSA Telnet 2.6</td>
<td>telnet, for login connection to other Internet computers</td>
<td>ftp.ncsa.uiuc.edu</td>
<td>/Telnet/Mac</td>
<td>Telnet2.6.sit.hqx</td>
</tr>
<tr>
<td>Fetch 2.1.1</td>
<td>ftp, file transfer protocol</td>
<td>ftp.mr.net</td>
<td>/pub/dialip/mac</td>
<td>Fetch_2.1.1.sithqx</td>
</tr>
<tr>
<td>Eudora 1.4.1</td>
<td>e-mail program</td>
<td>ftp.mr.net</td>
<td>/pub/dialip/mac</td>
<td>Eudora1.4.1.sea.hqx</td>
</tr>
<tr>
<td>Turbo Gopher 1.0.8</td>
<td>gopher browse utility</td>
<td>ftp.mr.net</td>
<td>/pub/dialip/mac</td>
<td>TurboGopher1.0.8b4.hqx</td>
</tr>
</tbody>
</table>

### Client programs for PC MS-DOS

<table>
<thead>
<tr>
<th>Client</th>
<th>Description</th>
<th>ftp host</th>
<th>ftp directory</th>
<th>file name</th>
</tr>
</thead>
<tbody>
<tr>
<td>NCSA Telnet 2.3.07</td>
<td>telnet, for login connection to other Internet computers</td>
<td>ftp.ncsa.uiuc.edu</td>
<td>/Telnet/DOS</td>
<td>telnet2307b.zip</td>
</tr>
</tbody>
</table>

### Tools for the Internet

**Help for the Local Technician**

**Internet Activities Using Scientific Data**

**Client programs for PC MSDOS**

<table>
<thead>
<tr>
<th>Client</th>
<th>Description</th>
<th>ftp host</th>
<th>ftp directory</th>
<th>file name</th>
</tr>
</thead>
<tbody>
<tr>
<td>NCSA Telnet 2.3.07</td>
<td>ftp, file transfer protocol</td>
<td>ftp.ncsa.uiuc.edu</td>
<td>/Telnet/DOS</td>
<td>telnet2307b.zip</td>
</tr>
</tbody>
</table>

**Client: Anarchie 1.31**
Description: archie, file search utility
ftp host: bitsy.mit.edu
ftp directory: /pub/mac/alpha-beta/newswatcher
file name: anarchie-131.sea.hqx

**Client: finger 1.37**
Description: finger, user-system information utility
ftp host: sumex-aim.stanford.edu
ftp directory: /info-mac/com/tcp
file name: finger-137.hqx

**Client: Chat 2.06**
Description: talk, converse with other users on line
ftp host: sumex-aim.stanford.edu
ftp directory: /info-mac/com/tcp
file name: chat-206.hqx

**Client: Mosaic 2.0**
Description: Mosaic, graphics-based WWW client
ftp host: ftp.ncsa.uiuc.edu
ftp directory: /Web/Mosaic/Mac
file name: NCSAMosaic200A8.68k.hqx

**Client: Netscape 0.93**
Description: Netscape graphics-based WWW client
ftp host: ftp.digital.com
ftp directory: /pub/net/infosys/Netscape/mac
file name: netscape093.sit.hqx
**Internet Activities Using Scientific Data**

- **Client: Pegasus 3.22**  
  Description: e-mail program  
  ftp host: ftp.iastate.edu  
  ftp directory: /pub/pc/email/pegasus  
  file name: pmail322.zip

- **Client: gopher**  
  Description: gopher browse utility  
  ftp host: ftp.msc.cornell.edu  
  ftp directory: /pub/dos/src/gopher  
  file name: gopher.exe

- **Client: archie**  
  Description: archie, file search utility  
  ftp host: nisc.jvnc.net  
  ftp directory: /pub/MSDOS/archie  
  file name: archie.zip

- **Client: finger**  
  Description: finger, user-system information utility  
  ftp host: ftp.msc.cornell.edu  
  ftp directory: /pub/dos/src/finger  
  file name: finger.exe

- **Client: talk 1.3**  
  Description: talk, converse with other users on line  
  ftp host: oak.oakland.edu  
  ftp directory: /pub/msdos/pktdrvr  
  file name: talk-13.zip

- **Client: lynx 0.8**  
  Description: lynx, text-based www browser  
  ftp host: ftp2.cc.ukans.edu  
  ftp directory: /pub/dos/lynx  
  file name: DL0_8A.EXE

**Client programs for PC Windows**

- **Client: telw**  
  Description: telnet, for login connection to other Internet computers  
  ftp host: ftp.ncsa.uiuc.edu  
  ftp directory: /Web/Mosaic/Windows/sockets  
  file name: included in winapps.zip

- **Client: ftpw**  
  Description: ftp, file transfer protocol  
  ftp host: ftp.ncsa.uiuc.edu  
  ftp directory: /Web/Mosaic/Windows/sockets  
  file name: included in winapps.zip

- **Client: Eudora 1.4**  
  Description: e-mail program  
  ftp host: ftp.mr.net  
  ftp directory: /pub/dialip/win/eudora14  
  file name: eudora14.exe

- **Client: hgopher**  
  Description: gopher browse utility  
  ftp host: ftp.mr.net  
  ftp directory: /pub/dialip/win  
  file name: hgopher.zip

- **Client: winarch**  
  Description: archie, file search utility  
  ftp host: ftp.ncsa.uiuc.edu  
  ftp directory: /Web/Mosaic/Windows/sockets  
  file name: included in winapps.zip

- **Client: finger 3.1**  
  Description: finger, user-system information utility  
  ftp host: ftp.iastate.edu  
  ftp directory: /pub/pc/winsock  
  file name: finger31.zip

- **Client: winchat**  
  Description: talk, converse with other users on line  
  ftp host: ftp.ncsa.uiuc.edu  
  ftp directory: /Web/Mosaic/Windows/sockets  
  file name: included in winapps.zip

- **Client: Netscape 0.94**  
  Description: Netscape graphics-based www client  
  ftp host: ftp.digital.com  
  ftp directory: /pub/net/infosys/Netscape/windows  
  file name: ns16-094.exe
Help for the Local Technician

Client: Mosaic 2.0
Description: Mosaic, graphics-based www browser
ftp host: ftp.ncsa.uiuc.edu
ftp directory: /Web/Mosaic/Windows
file name: wmos20a7.zip

Internet Activities Using Scientific Data

Client programs for UNIX

Client: telnet
Description: telnet, for login connection to other Internet computers
ftp host: (available on UNIX systems)

Client: ftp
Description: ftp, file transfer protocol
ftp host: (available on UNIX systems)

Client: mail
Description: e-mail program
ftp host: (available on UNIX systems)

Client: gopher
Description: gopher browse utility
ftp host: boombox.micro.umn.edu
ftp directory: /pub/gopher/Unix
file name: (select the one for your system)

Client: archie
Description: archie, file search utility
ftp host: ftp.sura.net
ftp directory: /pub/archie/clients
file name: (select the one for your system)

Client: finger
Description: finger, user-system information utility
ftp host: (available on UNIX systems)

Client: talk
Description: talk, converse with other users on line
ftp host: ftp.iastate.edu
ftp directory: /pub/netbsd/NetBSD–current/src/src/usr/bin/talk
file name: (select the one for your system)

Client: Mosaic 2.4
Description: Mosaic, graphics-based www browser
ftp host: ftp.ncsa.uiuc.edu
ftp directory: /Web/Mosaic/Unix/binaries/2.4
file name: (select the one for your system)

Client: Netscape 0.94
Description: Netscape graphics-based www client
ftp host: ftp.digital.com
ftp directory: /pub/net/infosys/Netscape/unix
file name: (select the one for your system)

Client: lynx
Description: lynx, text-based www browser
ftp host: ftp2.cc.ukans.edu
ftp directory: /pub/lynx
file name: (select the one for your system)
## Getting Other Programs to Support Internet Work

The following list provides anonymous ftp sources for common viewers, TCP/IP programs, communications programs, and file uncompress programs:

### Other programs for Macintosh

<table>
<thead>
<tr>
<th>Program</th>
<th>Description</th>
<th>ftp host</th>
<th>ftp directory</th>
<th>file name</th>
</tr>
</thead>
<tbody>
<tr>
<td>MACTCP</td>
<td>tcp/ip transport program</td>
<td>ftp.ncsa.uiuc.edu</td>
<td>/Web/Mosaic/Mac/Helpers</td>
<td>jpegview-33.hqx</td>
</tr>
<tr>
<td>JpegView 3.3</td>
<td>gif/jpeg picture viewer</td>
<td>ftp.ncsa.uiuc.edu</td>
<td>/Web/Mosaic/Mac/Helpers</td>
<td>sparkle-215.hqx</td>
</tr>
<tr>
<td>Sparkle 2.15</td>
<td>mpeg movie viewer</td>
<td>ftp.ncsa.uiuc.edu</td>
<td>/Web/Mosaic/Mac/Helpers</td>
<td>soundmachine-21.hqx</td>
</tr>
<tr>
<td>Sound Machine 2.1</td>
<td>sound player</td>
<td>ftp.ncsa.uiuc.edu</td>
<td>/Web/Mosaic/Mac/Helpers</td>
<td>Stuffit Expander 3.51</td>
</tr>
</tbody>
</table>

### Other programs for PC MS-DOS

<table>
<thead>
<tr>
<th>Program</th>
<th>Description</th>
<th>ftp host</th>
<th>ftp directory</th>
<th>file name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crynwr Packet Drivers</td>
<td>tcp/ip transport program</td>
<td>oak.oakland.edu</td>
<td>/pub/msdos/pktdrvr</td>
<td>drivers.zip</td>
</tr>
<tr>
<td>Image Viewer 1.02</td>
<td>gif/jpeg picture viewer</td>
<td>oak.oakland.edu</td>
<td>/pub/msdos/graphics</td>
<td>ivl_02a.zip</td>
</tr>
<tr>
<td>MPEGView</td>
<td>mpeg movie viewer</td>
<td>oak.oakland.edu</td>
<td>/pub/msdos/graphics</td>
<td>mpegview.zip</td>
</tr>
<tr>
<td>Play Any 1.2</td>
<td>sound player</td>
<td>oak.oakland.edu</td>
<td>/pub/msdos/sound</td>
<td>plany12.zip</td>
</tr>
<tr>
<td>TeleMate 4.00</td>
<td>modem communications program</td>
<td>ftp.utas.edu.au</td>
<td>/pub/dos/comm/telemate</td>
<td>tm400-1.zip, tm400-2.zip, tm400-3.zip, tm400-4.zip</td>
</tr>
<tr>
<td>Unzip</td>
<td>file uncompress utility</td>
<td>wuarchive.wustl.edu</td>
<td>/systems/ibmpc/simtel</td>
<td>UNZIP.EXE</td>
</tr>
</tbody>
</table>
## Other programs for PC Windows

**Program: TCPMAN**  
**Description:** tcp/ip transport program  
**ftp host:** ftp.ncsa.uiuc.edu  
**ftp directory:** /Web/Mosaic/Windows/sockets  
**file name:** (included in winsock.zip)

**Program: LView 3.1**  
**Description:** gif/jpeg picture viewer  
**ftp host:** ftp.ncsa.uiuc.edu  
**ftp directory:** /Web/Mosaic/Windows/viewers  
**file name:** lview31.zip

**Program: MPEG Player 3.2**  
**Description:** mpeg movie viewer  
**ftp host:** ftp.ncsa.uiuc.edu  
**ftp directory:** /Web/Mosaic/Windows/viewers  
**file name:** mpegw32e.zip

**Program: Play Any for Windows**  
**Description:** sound player  
**ftp host:** ftp.ncsa.uiuc.edu  
**ftp directory:** /Web/Mosaic/Windows/viewers  
**file name:** wpiny09b.zip

**Program: MicroLink 0.90**  
**Description:** modem communications program  
**ftp host:** oak.oakland.edu  
**ftp directory:** /pub/msdos/windows3  
**file name:** mlk090.zip

**Program: Unzip**  
**Description:** file uncompress utility  
**ftp host:** wuarchive.wusl.edu  
**ftp directory:** /systems/ibmpc/simtel  
**file name:** UNZIP.EXE

## Other programs for UNIX

**Program: tcp/ip**  
**Description:** tcp/ip transport program  
**ftp host:** (available on UNIX systems)

**Program: XView 3.00**  
**Description:** gif/jpeg picture viewer  
**ftp host:** ftp.ncsa.uiuc.edu  
**ftp directory:** /Web/Mosaic/Unix/viewers  
**file name:** xv-3.00.tar.Z

**Program: MPEG Player**  
**Description:** mpeg movie viewer  
**ftp host:** ftp.ncsa.uiuc.edu  
**ftp directory:** /Web/Mosaic/Unix/viewers  
**file name:** mpeg-play-2.0.tar.Z

**Program: ZModem**  
**Description:** modem communications program  
**ftp host:** shiva.com  
**ftp directory:** /src/UTIL/TRANSFER  
**file name:** zmodem.tar.Z

**Program: gunzip**  
**Description:** file uncompress utility  
**ftp host:** beech.cic.net  
**ftp directory:** /pub/E'EVENT/gzip/unix-binaries  
**file name:** (select the one for your system)
Moving Files and Programs to PC or MAC

Software: public domain, freeware, and shareware

The software programs that you obtain using ftp on the Internet may be "in the public domain," or they may be "freeware" or "shareware." In each case, the software developer has determined the conditions for your use of the program.

- **Shareware** usually can be tested for a limited amount of time for no charge. If you decide to keep and continue using the software, you are obligated to register and pay for it. Sometimes certain features of the program are disabled until you register. Usually, you are allowed to give these programs to other people under certain conditions (for example, all copyright notices and documentation must accompany the distribution). Shareware usually is copyrighted.

- **Freeware** is similar to shareware, except that the developer does not charge for use of the program. There are still restrictions on how the programs are distributed, and the software is copyrighted.

- **Public-domain** software usually is released by the developer free of charge and free of restrictions on use and distribution.

Sometimes you will find variations on the conditions listed here. Always read the documentation files that come with the programs, and always abide by the developer’s terms. It is especially important that you pay the shareware fees for the programs that you use. Most shareware developers are professionals who depend on the fees for their livelihoods to continue improvements and development of new software.

Computer viruses

If you ftp files from remote computers on the Internet, you should protect your computer against infection by computer viruses. In fact, any computer that receives data from the outside world—from the Internet, a local area network (LAN) or a floppy disk—should have a good virus-protection program installed. You can buy one from a computer software store, or you can get shareware virus-protection programs from the Internet. The following are two good ones:

- For PC computers
  - Microsoft Anti-Virus for Windows (included with MS-DOS and MS-DOS upgrades)

- For Macintosh computers
  - Disinfectant (freeware)

Many other shareware programs for virus detection and removal are available on the Internet.
Modem File Transfers

If you are using a dial-up connection, sooner or later you will want to transfer a file to your computer (the machine that is on your desk). To accomplish a file transfer from the host computer to your computer, two requirements must be satisfied:

- The host computer must have a file transfer program (kermit and sz (for send using zmodem) are common ones).
- Your computer’s communications program must have file transfer capability that matches the method used by the host computer (kermit or zmodem).

Almost all host computers have kermit, and some have sz. To find out what is available, just try out the command at the > prompt. If the program is available, you’ll see a brief “help” screen. If not, you’ll get a not found message.

To find out what methods your communications program can use, check the file transfers (or similar) menu. If possible, select zmodem; it’s faster and can automatically recover if your file transfer is interrupted (someone picks up the extension phone, etc.). Note that in MS Windows 3.1, the Terminal program can only use kermit. This is a disadvantage for transferring large files. Get a good communications program with zmodem!

Once you have decided on the method that you’ll use, transferring a file is simple. Suppose you are downloading a file named earth.gif from the host computer to your computer.

Here’s the kermit method:

At the host computer’s prompt:

```
> kermit -l -s earth.gif
```

The -s option means “send.” The -l option is needed only if you are sending a binary file (like a picture, program, or compressed file).

In your communications program, use the file transfer (or similar) menu to receive using kermit. Depending on the communications program, you may be asked to specify where the file should be placed on your hard disk (i.e., which directory). The file transfer will then proceed automatically.

And here is the (better) zmodem method:

At the host computer’s prompt:

```
> sz earth.gif
```

In your communications program, use the file transfer (or similar) menu to receive using zmodem. Zmodem will start automatically in many communications programs, making the receive command unnecessary.
File Types and Viewers

File extensions

Many files that you'll encounter on the Net have an extension as part of the name; here are some examples:

- moon.gif (gif extension)
- readme.txt (txt extension)
- signif_EQ.zip (zip extension)

Extensions provide a "label" that often gives a clue as to the type of the file. Not all files have extensions, and extensions are not always used consistently. But the name of the file can often give you an idea of what's in the file, and the extension suggests what type of file it is. Here is a partial collection of common extensions that you'll see on the Net:

- .txt: text, simple ASCII characters
- .exe: an executable (program), usually for a PC
- .zip: compressed IBM
- .sit: compressed Macintosh
- .cpt: compressed Macintosh
- .hqx: ASCII-encoded Macintosh
- .gif: graphic interchange format, common for pictures
- .jpg: space-saving picture format
- .mpg: movie or animation
- .avi: movie or animation
- .bmp: picture
- .pcx: picture
- .wav: sound
- .au: sound
- .mp2: sound
- .tif: picture
- .bin: binary encoded
- .Z: compressed UNIX
- .gz: gzipped UNIX
- .tar: archived UNIX

You can save time by checking the extensions. For instance, if you are using a Macintosh computer don't bother getting a file with a .zip extension; it won't run on your machine.

Using viewers

A viewer is a program that you use on your computer to look at picture files or movie files. There are many different viewers available; many are freeware or shareware.

Two commonly available viewers that work with MS Windows are lview and mpegplay. Lview allows you to look at .gif, .jpg, and other picture files. Mpegplay lets you view .mpg movies.

So, how do you get these programs? Why, with ftp, of course! See the section "Getting Internet tools."
Compressed files

Many files that you find on the Internet will be stored in compressed form. Compressed files take less storage space and require less time to transfer (especially important if you are using a dial-up connection!). Also, complete directory structures can be placed in a single file for easy transfer. Usually the extension on the file will tell you what kind of file you have. Here are several of the most common file-compression methods that you are likely to encounter on the Net:

- **.zip files** For PC computers. Use pkunzip.exe or unzip.exe to uncompress. These are available at many locations on the Net as shareware.
- **.arj files** For PC computers. Use arj.exe to extract.
- **.sit files** For Macintosh computers. Uncompress with stuffit_expander (freeware), Stuffit Lite (shareware), or a similar program.
- **.cpt files** For Macintosh computers. Uncompress with stuffit_expander (freeware), Compactor Pro (shareware) or similar programs.
- **.hqx files** For Macintosh computers. Not actually compressed, but “binhex encoded,” an ASCII (text) version of a binary file. Allows a binary file to be handled by programs that can only work with ASCII files. These can be converted back to the original version by using stuffit_expander, Stuffit Lite, or similar.
- **.Z files** For UNIX computers. Can be uncompressed by using the uncompress program that is available on most UNIX computers.
  
  uncompress file_name.Z

  In this example, the uncompressed file would be written to a file called file_name without the .Z extension.

- **.gz files** For UNIX computers. Can be uncompressed with the gunzip program:
  
  gunzip file_name.gz

  In this example, the file would be converted to file_name (without the .gz). Use gunzip to uncompress (and its reciprocal program gzip to compress).

- **.tar files** For UNIX computers, usually used to save several files and a directory structure in a single file. tar stands for “tape archive” but it is often used with disk files. To uncompress:
  
  tar -xvf file_name.tar

  All of the files and directories in the .tar file will be recreated, starting from the correct directory.

Explanations on how to unzip and uncompress are in Activity 5.
UNIX

Most Internet computers that you use or connect to will be using some form of the UNIX operating system. UNIX is not very user friendly, but you really only need to know a few commands to use the Internet. You can get endless details on UNIX from the many books on the market. Here is some very brief information on directories, the on-line help manual, and useful commands.

Directories

UNIX organizes the files on a computer with a directory system that resembles an upside-down tree. The top directory is called root, and is designated with a / . Subdirectories under the root directory have names, and subdirectories may themselves have subdirectories.

To change to a particular subdirectory, you would use the cd (change directory) command:

cd /users/jlopez

To see what directory you are currently using, use pwd (print working directory):

pwd

Once in a particular directory, you don’t need to specify the complete directory name to change to the next lower directory. For example, say you are currently in /users/jlopez . To move to /users/jlopez/pictures , use:

cd pictures

You could use pwd to check where you are. To move up to the next higher directory, you can use the shorthand name for the next higher directory, which is .. (two dots):

cd ..

Note that there is a space after the cd command and before the two dots.

To move to your “home” directory (the one that you login to), use:

cd

Finally, once you have “navigated” to the desired directory, it would be nice to see what’s there. Use the UNIX command for “list:”

ls -l

Sometimes the MS-DOS command dir will work on a UNIX computer:

dir

Each line of the content listing designates either a file or another subdirectory. You can tell the difference easily: lines showing files start with – (a dash), and lines showing subdirectories start with d.

To summarize, you should be able to get around in a UNIX computer with cd, pwd, and ls -l.

The manual

Most UNIX systems have a “manual;” it’s a type of on-line help. The manual pages aren’t very easy to read, but you may be able to get the detail you need on a command that is giving you trouble. For example, here is the command to get information on the passwd command:

man passwd

You will receive several pages to read. You may read each page and then get “more” by pressing the <spacebar> after each page. You can press <ctrl>c to exit from the manual display at any time.
Help for the Local Technician

Internet Activities Using Scientific Data

Useful Commands in UNIX

Here are some of the more commonly used UNIX commands. Note that there is always a space between the command and options or names.

- **cd** change directory to your home directory
- **cd directory** move to directory
- **pwd** print working directory
- **ls -l** list files in current directory
- **passwd** change your password
- **rm filename** remove (delete) files
- **cat filename** display file contents on screen
- **more filename** display file contents one page at a time
  
  *more can be appended to some commands to cause the display to pause for each page*
- **cp source_file destination_file** copy a file
- **mv source_file destination_file** move or rename a file and delete the original file
- **talk user_email_address** talk to another on-line Internet user
- **write user_email_address** send a message to an on-line Internet user
- **finger user_email_address** get information about an Internet user
- **mesg y or mesg n** accept or reject requests to "talk" or "write" messages
- **mkdir directory_name** make a new directory
- **rmdir directory_name** remove directory (must be empty)
- **logout** leave your Internet account
- **exit or quit** often used to terminate a program
- **<control>^c** will often abort the program that is running on the remote Internet computer
- **man UNIX_command** get information on a UNIX command
Activity 1

1. What organization responded to your test e-mail message?

2. Where is the computer that returned your message (city and state)?

3. Send another message and this time make an intentional error when you type the e-mail address. What happens?

4. What is different about communicating with e-mail rather than person-to-person?

5. Is it easy for someone to forward your mail to someone else? What implications does this have?
Activity 2

1. What kind of information can you get on a user with finger?

2. Do you get different user information from different sites?

3. Find the strongest quake in the last few days. Hint: Look at the magnitude column (MAG).

4. Find a quake that is in the southern hemisphere.

5. Mark the location of each quake or tremor on a map of the world. Where is most of the activity in the last few days?
Activity 2 — continued

6. Check the activity every day for a week, plotting each new record. What patterns do you see?

7. Get a geography book that has a map showing the Earth's major tectonic plates. Draw the plate boundaries on your map. How do the boundary lines relate to recent seismic activity?

8. Jane's latitude and longitude are approximately 34° N, 118° W. Was there a small earthquake near her home today?
Activity 3

1. What experiments will be done in the cabin on the next space shuttle mission?

2. What delays (if any) have occurred in the launch schedule?

3. Find the title of a book at the Los Angeles Public Library that is about experiencing weightlessness on the space shuttle.

4. What information would you need to copy down in order to find the book when you go to the library?

5. Find a story by Isaac Asimov about being weightless.
Activity 4

1. What is the weather like in San Francisco today?

2. Jane had to call her friends that night to tell them what the weather was going to be and where they were going tomorrow. Her choices could be diagrammed as shown. What did they decide to do based on today's weather in San Diego and Las Vegas?

   ![Weather Decision Diagram]

   - Beach >80°F? YES → Go to the Beach
   - Beach >80°F? NO → Desert <100°F? YES → Go to the Desert
   - Desert <100°F? NO → Go to the Mall

3. How are the two views of the 1994 annular eclipse different? Where were the photographs made?

4. Find a map of the path of the eclipse. What part of the United States saw the annular eclipse?
Activity 4 — continued

5. Where in the world was the "02625" iceberg? Plot its initial location on a graph.

6. On the graph, plot the path of the berg while it was under observation.

7. Determine the approximate fastest speed of the berg in knots.
1. Which Internet computer has zterm?

2. Use archie to locate a "paint" program for your computer. Which Internet computer has such a program? What is the directory and file name?

3. Describe the game. What is the game's best characteristic?
Activity 6

1. How many years of data are available?

2. Describe any patterns that you see in the data.

3. After plotting the data, describe the pattern in the sunspot data. Which recent year had a high count? a low count? How many years passed between the last two peaks?

4. When the geomagnetic activity forecast is more than “quiet,” disturbances to radio transmission are possible. What should Elvis recommend doing about the music? (Hint: look at parts II and III).
Activity 7

1. Where are the four most active seismic regions in the world?

2. Why do there appear to be so many quakes in recent years?

3. What was the magnitude of the strongest earthquake in the database?

4. Where have most of the strongest earthquakes occurred?

5. Where in the world did that largest magnitude earthquake occur?

6. When did the largest magnitude quake happen?

7. A very large earthquake occurred in China in the 20th century. When did the quake occur (year, month, day)? How many people died?
8. What did Jane conclude about earthquake hazards in the five cities (Seattle; Ocean View, DE; Tampa, Tokyo; and Sydney)?

9. What is the name of the bay in the lower right corner of the map?

10. Figure out the size of the piece of land represented by each square on your screen (that is, are the squares 100 feet by 100 feet? one mile by one mile?).

11. What is the land-use number for deciduous forests?

12. How are the deciduous forests in the Ocean View area distributed?

13. What is the South African climate like?

14. What conclusions could Jane draw from the data she saw? Are there trees around Ocean View? And knowing what the earthquake data showed, do you see a clear preference in the choices her father had presented?
Activity 8

1. What are the temperatures in Los Angeles and Norfolk today?

2. What is the wind direction and speed in each city?

3. What is the sky cover in each city?

4. What is the barometric pressure in millibars in each city? (Hint: on surface maps “987” means 998.7 millibars; “183” means 1018.3 millibars.)

5. How are the Upper Air data obtained?

6. How often are measurements made?

7. What is the approximate barometric pressure at 30,000 feet?

8. How are the weather symbols used on the Upper Air maps? (Although the symbols used are identical, there are differences in how they are used on Surface Maps and on Upper Air Maps.)
Activity 8—continued

9. Draw an imaginary line between Los Angeles and Norfolk on the map. What wind directions and speeds do you find for stations on or near the flight path?

10. What is the prevailing (typical) direction at 30,000 feet? Will the wind help or hinder an aircraft flying from Los Angeles to Norfolk?

11. What will be the temperature of the air outside the aircraft at 30,000 feet?

12. What time was the 300 mb wind-speed contour data taken?

13. On the 300 mb map, how does the speed in knots vary over the path from L.A. to Norfolk?

14. What is the fastest wind speed (in knots) that will be encountered on the flight? What is the fastest wind speed in miles per hour?

15. What important information not shown on this picture was on the other 300 mb map?
1. What trends do you observe in the monthly CO₂ concentration at the South Pole?

2. If the CO₂ concentration at the South Pole continues to increase at the same rate, how many years will it take to double?

3. Use lynx to view the monthly concentrations of methane (CH₄) at the South Pole. At the same rate of increase, how many years will it take to double the CH₄ concentration?